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Chapter 1

Introduction

This document describes how to install, configure, and implement the Sun SeeBeyond 
eWay™ Adapter for PeopleSoft (also called the PeopleSoft eWay throughout this 
document) in a typical eGate™ environment.

This chapter provides a brief overview the PeopleSoft eWay, as well as a introduction to 
this user’s guide.

What’s in This Chapter

About PeopleSoft on page 7

About the PeopleSoft eWay on page 7

What’s in This Document on page 8

Sun Microsystems, Inc. Web Site on page 10

Documentation Feedback on page 10

1.1 About PeopleSoft
PeopleSoft’s Enterprise Resource Planning (ERP) software is a full-function application 
package that offers business applications for financials, human resources, customer 
relations, supply chain management, materials management, and business analytics. 
PeopleSoft provides what it calls “pure-Internet” architecture: Web-based applications 
designed to streamline a company’s operations by integrating systems to effectively 
connect it’s various departments, customers, and suppliers.

1.2 About the PeopleSoft eWay
The Sun Java Composite Application Platform Suite and the PeopleSoft eWay enable 
PeopleSoft to easily and transparently integrate with legacy systems, enterprise 
applications, and other platforms. The Sun SeeBeyond eWay™ Adapter for PeopleSoft 
exposes JCA and Web services compliant interfaces for the purpose of application and 
business integration. 
PeopleSoft eWay User’s Guide 7 Sun Microsystems, Inc.
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1.3 What’s New in This Release
The Sun SeeBeyond eWay™ Adapter for PeopleSoft includes the following changes and 
new features:

New for Version 5.1.3

This is a maintenance release. No new features.

New for Version 5.1.2

This is a maintenance release. No new features.

New for Version 5.1.1

This is a maintenance release. No new features.

New for Version 5.1.0

Version Control: An enhanced version control system allows you to effectively 
manage changes to the eWay components.

Multiple Drag-and-Drop Component Mapping from the Deployment Editor: The 
Deployment Editor now allows you to select multiple components from the 
Editor’s component pane, and drop them into your Environment component.

Support for Runtime LDAP Configuration: eWay configuration properties now 
support LDAP key values.

Connectivity Map Generator: Generates and links your Project’s Connectivity Map 
components using a Collaboration or Business Process.

Many of these features are documented further in the Sun SeeBeyond eGate™ Integrator 
User’s Guide or the Sun SeeBeyond eGate™ Integrator System Administrator Guide.

1.4 What’s in This Document
This guide contains the following information:

Chapter 1 “Introduction” on page 7 provides an overview of the PeopleSoft eWay 
and the PeopleSoft eWay User’s Guide.

Chapter 2 “Installing the PeopleSoft eWay” on page 11 provides the supported 
operating systems and system requirements for the PeopleSoft eWay. It also 
describes how to install the PeopleSoft eWay, its documentation, and its sample 
Projects.

Chapter 3 “Configuring the eWay Properties” on page 19 describes the process for 
configuring the PeopleSoft eWay to run in your environment.

Chapter 4 “Configuring the PeopleSoft Server for the PeopleSoft eWay Projects” 
on page 36 describes how to configure the PeopleSoft server to work with the 
PeopleSoft eWay.
PeopleSoft eWay User’s Guide 8 Sun Microsystems, Inc.
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Chapter 5 “Using the PeopleSoft eWay with eInsight” on page 62 describes how 
to use the PeopleSoft eWay with the eInsight Business Process Manager and the 
Web Services interface.

Chapter 6 “Using the PeopleSoft eWay with Java Collaborations” on page 81 
describes how to implement a PeopleSoft eWay Project that uses Java Collaboration 
Definitions to provide the business logic.

Appendix A “Generating DTDs from PeopleSoft 8.13” on page 102 describes how 
to generate DTDs from PeopleSoft 8.13, and use these DTDs to create the OTDs 
used to create the business logic for the PeopleSoft eWay. 

1.4.1 Scope of the Document
This user’s guide provides a description of the Sun SeeBeyond eWay™ Adapter for 
PeopleSoft. It includes directions for installing the eWay, configuring the eWay 
properties, and implementing the eWay’s sample Projects. This document is also 
intended as a reference guide, listing available properties, functions, and 
considerations. 

1.4.2 Intended Audience
This guide is intended for experienced computer users who have the responsibility of 
helping to set up and maintain a fully functioning Java Composite Application 
Platform Suite system. This person must also understand any operating systems on 
which the Java Composite Application Platform Suite will be installed (Windows and 
UNIX), and must be thoroughly familiar with Windows-style GUI operations.

1.4.3 Text Conventions
The following conventions are observed throughout this document.

Table 1   Text Conventions

Text Convention Used For Examples

Bold Names of buttons, files, icons, 
parameters, variables, methods, 
menus, and objects

Click OK.
On the File menu, click Exit.
Select the eGate.sar file.

Monospaced Command line arguments, code 
samples; variables are shown in 
bold italic

java -jar filename.jar

Blue bold Hypertext links within 
document

See Text Conventions on page 9

Blue underlined Hypertext links for Web 
addresses (URLs) or email 
addresses

http://www.sun.com
PeopleSoft eWay User’s Guide 9 Sun Microsystems, Inc.
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1.5 Sun Microsystems, Inc. Web Site
The Sun Microsystems web site is your best source for up-to-the-minute product news 
and technical support information. The site’s URL is:

http://www.sun.com

1.6 Documentation Feedback
We appreciate your feedback. Please send any comments or suggestions regarding this 
document to:

CAPS_docsfeedback@sun.com
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Chapter 2

Installing the PeopleSoft eWay

This Chapter describes how to install the Sun SeeBeyond eWay™ Adapter for 
PeopleSoft, as well as the accompanying documentation and sample Projects. 

What’s in This Chapter

PeopleSoft eWay System Requirements on page 11

Installing the PeopleSoft eWay on page 12

Installing the HTTP Publication Handler for PeopleTools 8.13 on page 15

Updating the eGate API Kit on page 16

ICAN 5.0 Project Migration Procedures on page 16

2.1 PeopleSoft eWay System Requirements
The PeopleSoft eWay Readme contains the latest information on:

Supported Operating Systems

System Requirements

External System Requirements

The PeopleSoft eWay Readme is uploaded with the eWay’s documentation file 
(PeopleSofteWayDocs.sar) and can be accessed from the Documentation tab of the 
Sun Java Integrator Suite Installer. Refer to the PeopleSoft eWay Readme for the 
latest requirements before installing the PeopleSoft eWay.

HTTP and JMS Support

The table below shows the support for inbound and outbound Business Processes and 
Collaborations depending on what version of PeopleSoft is used. The PeopleSoft eWay 
does not support JMS inbound and outbound Business Processes and Collaborations 
for PeopleTools 8.13. These are supported for PeopleTools 8.42. 

Table 2   JMS and HTTP Support—PeopleTools 8.13

HTTP inbound HTTP outbound JMS inbound JMS outbound

eInsight yes yes no no
PeopleSoft eWay User’s Guide 11 Sun Microsystems, Inc.
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2.2 Installing the PeopleSoft eWay 
The Sun Java Composite Application Platform Suite Installer, a web-based application, 
is used to select and upload eWays and add-on files during the installation process. The 
following section describes how to install the components required for this eWay.

Note: When the Repository is running on a UNIX operating system, the eWays are loaded 
from the Enterprise Manager running on a Windows platform connected to the 
Repository server using Internet Explorer.

2.2.1 Installing the eWay on a JavaCAPS Supported System
Follow the directions for installing the Sun Java Composite Application Platform Suite 
in the Sun Java Composite Application Platform Suite Installation Guide. After you have 
installed eGate or eInsight, do the following:

1 From the Sun Java Composite Application Platform Suite Installer’s Select Sun 
Java Composite Application Platform Suite Products to Install table 
(Administration tab), expand the eWay option. 

2 Select the products for your Sun Java Composite Application Platform Suite and 
include the following:

FileeWay (the File eWay is used by most sample Projects)

PeopleSofteWay

To upload the PeopleSoft eWay User’s Guide, Help file, Javadoc, Readme, and 
sample Projects, select the following:

PeopleSofteWayDocs

3 Once you have selected all of your products, click Next in the top-right or bottom-
right corner of the Select Sun Java Composite Application Platform Suite 
Products to Install box.

4 From the Selecting Files to Install box, locate and select your first product’s SAR 
file. Once you have selected the SAR file, click Next. Your next selected product 

eGate only yes yes no no

Table 3   JMS and HTTP Support—PeopleTools 8.42

HTTP inbound HTTP outbound JMS inbound JMS outbound

eInsight yes yes yes yes

eGate only yes yes yes yes

Table 2   JMS and HTTP Support—PeopleTools 8.13

HTTP inbound HTTP outbound JMS inbound JMS outbound
PeopleSoft eWay User’s Guide 12 Sun Microsystems, Inc.
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appears. Follow this procedure for each of your products. The Installation Status 
window appears and installation begins after the last SAR file has been selected.

5 Once your product’s installation is finished, continue installing the Suite as 
instructed in the Sun Java Composite Application Platform Suite Installation Guide. 

Adding the eWay to an Existing Suite Installation

If you are adding the eWay to an existing Sun Java Composite Application Platform 
Suite installation, do the following:

1 Complete steps 1 through 4 above.

2 Once your product’s installation is finished, open the Enterprise Designer and 
select Update Center from the Tools menu. The Update Center Wizard appears.

3 For Step 1 of the wizard, simply click Next.

4 For Step 2 of the wizard, click the Add All button to move all installable files to the 
Include in Install field, then click Next.

5 For Step 3 of the wizard, wait for the modules to download, then click Next.

6 The wizard’s Step 4 window displays the installed modules. Review the installed 
modules and click Finish.

7 When prompted, restart the IDE (Integrated Development Environment) to 
complete the installation. 

2.2.2 Installing eWay Enterprise Manager plug-ins
The Sun SeeBeyond Enterprise Manager is a Web-based interface that allows you to 
monitor and manage your Java Integration Suite applications. The Enterprise Manager 
requires an eWay specific “plug-in” for each of your installed eWays. These plug-ins 
enable the Enterprise Manager to target specific alert codes for each eWay type, as well 
as to start and stop the inbound eWays. 

The Sun Java Composite Application Platform Suite Installation Guide describes how to 
install the Sun SeeBeyond Enterprise Manager. The Sun SeeBeyond eGate™ Integrator 
System Administration Guide describes how to monitor servers, Services, logs, and alerts 
using the Sun SeeBeyond Enterprise Manager and the command-line client. 

The eWay Enterprise Manager plug-ins are available from the List of Components to 
Download under the Sun Java Composite Application Platform Suite Installer’s 
DOWNLOADS tab. 

There are two ways to add the eWay Enterprise Manager plug-ins:

1 From the Enterprise Manager:

A From the Enterprise Manager’s Explorer toolbar, click the Configuration icon. 

B Click the Web Applications Manager tab, go to the Auto-Install from 
Repository tab, and connect to your Repository.
PeopleSoft eWay User’s Guide 13 Sun Microsystems, Inc.
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C Select the application plug-ins you require. Be sure to include the eWays Base 
Enterprise Manager Plug-In. Click Install. The application plug-ins are 
installed and deployed.

2 From the Sun Java Composite Application Platform Suite Installer:

A From the Sun Java Composite Application Platform Suite Installer’s 
Download tab, select the Plug-Ins you require and save them to a temporary 
directory. 

B Log onto the Sun SeeBeyond Enterprise Manager. From the Enterprise 
Manager’s Explorer toolbar, click the Configuration icon.

C Click the Web Applications Manager tab and go to the Manage Applications 
tab.

D Browse to and select the WAR file for the application plug-in that you 
downloaded, and click Deploy. The plug-in is installed and deployed.

PeopleSoft eWay Alert Codes

You can view and delete alerts using the Enterprise Manager. An alert is triggered 
when a specified condition occurs in a Project component. The purpose of the alert is to 
warn the administrator or user that a condition has occurred. 

To View the eWay Alert Codes

1 Add the eWay Enterprise Manager plug-in for this eWay.

2 From the Enterprise Manager’s Explorer toolbar, click the Configuration icon.

3 Click the Web Applications Manager tab and go to the Manage Alert Codes tab. 
Your installed alert codes are displayed under the Results section. If your eWay 
alert codes are not available displayed under Results, do the following

A From the Install New Alert Codes section, browse to and select the eWay alert 
properties file for the application plug-in that you added. The alert properties 
files are located in the alertcodes folder of your Sun Java Composite Application 
Platform Suite installation directory.

B Click Deploy. The available alert codes for your application are displayed under 
Results. A listing of available this eWay’s alert codes is displayed in Table 4 for 
PeopleSoft Client, and Table 5 on page 15 for PeopleSoft Server.

Table 4   PeopleSoft Client eWay Alert Codes

Alert Code Description User Actions

PSOFTHTTPCLIENTEWAY-
CONFIG-FAILED000001

 Configuration error 
encountered for Peoplesoft 
HTTP Client eWay.

Verify eWay Environment 
configuration properties are valid.

PSOFTHTTPCLIENTEWAY-
CONNECT-FAILED000002

 Failed to prepare the 
Peoplesoft HTTP Client agent 
for establishing the 
connection to the HTTP 
server.

Verify that the PeopleSoft server is 
running.
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Table 5   PeopleSoft Server eWay Alert Codes

An alert code is a warning that an error has occurred. It is not a diagnostic. The user 
actions noted above are just some possible corrective measures you may take. Refer to 
the log files for more information. For information on managing and monitoring alert 
codes and logs, see the Sun SeeBeyond eGate Integrator System Administration Guide. 

2.2.3 After Installation
Once you install the eWay, it must then be incorporated into a Project before it can 
perform its intended functions. See the Sun SeeBeyond eGate™ Integrator User’s Guide for 
more information on incorporating the eWay into an eGate Project.

2.3 Installing the HTTP Publication Handler for 
PeopleTools 8.13

If you are using PeopleTools 8.13, you must install the HTTP Publication Handler as 
described in this section. 

After the installation, configure the subscription handler as described in “Adding the 
HTTP publication handler” on page 59.

Installing the HTTP Publication Handler On Windows

1 Stop the web server (Apache or WebLogic).

2 Stop the PeopleSoft 8 Application Server for the appropriate domain.

3 Extract the com.stc.eways.psofthttphandler.jar file from the PeopleSofteWay.sar.

4 For Apache, copy the JAR file to the servlets subdirectory under the servlet engine 
installation directory.

5 For WebLogic, copy the JAR file to the servletclasses subdirectory under the 
weblogic\myserver directory in the PeopleSoft domain installation; for example:

\weblogic\myserver\servletclasses

PSOFTHTTPCLIENTEWAY-
POST-FAILED000005

 Failed on HTTP POST request 
to URL {0}.

Verify eWay Environment 
configuration properties are 
valid.
Verify that the PeopleSoft server 
is running.

Alert Code Description User Actions

PSOFTHTTPSERVEREWAY-
REQUEST-FAILED000001

 Failed to process the 
POST or GET request.

Message cannot be processed. Verify 
that your message content is compatible 
with PeopleSoft.

Alert Code Description User Actions
PeopleSoft eWay User’s Guide 15 Sun Microsystems, Inc.
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6 Extract the contents of the JAR file. 

7 Start (boot) the Application Server for the appropriate domain.

8 Start the web server.

Installing the HTTP Publication Handler on UNIX

1 Stop the Web server (Apache or WebLogic).

2 Stop the PeopleSoft 8 Application Server for the appropriate domain.

3 Extract the com.stc.eways.psofthttphandler.jar file from the PeopleSofteWay.sar.

4 For Apache, copy the JAR file to the servlets subdirectory under the websrv 
directory in the PeopleSoft domain installation; for example:

/psoft/FDM80/websrv/servlets

5 For WebLogic, copy the JAR file to the servletclasses subdirectory under the 
weblogic/myserver directory in the PeopleSoft domain installation; for example:

/do1/psoft/fdm80/weblogic/myserver/servletclasses

6 Extract the contents of the JAR file with the following command:

jar -tf com.stc.eways.psofthttphandler.jar

7 Start (boot) the Application Server for the appropriate domain.

8 Start the Web server.

2.4 Updating the eGate API Kit
The eGate API Kit provides an interface for PeopleSoft client applications to exchange 
data with eGate Projects via the Sun Java Composite Application Platform Suite JMS. 
To update the Sun Java Composite Application Platform Suite and the PeopleSoft eWay 
to use the 5.1.3 eGate API Kit, install the 5.1.3 eGate API Kit as instructed by the Sun 
SeeBeyond eGate API Kit Developer’s Guide.

2.5 ICAN 5.0 Project Migration Procedures
This section describes how to transfer your current ICAN 5.0 Projects to Sun Java 
Composite Application Platform Suite, version 5.1.3. Only Projects developed on ICAN 
5.0.2 and above can be migrated successfully to the Sun Java Composite Application 
Platform Suite. To migrate your ICAN 5.0 Projects, do the following:

Export the Project

1 Before you export your Projects, save your current ICAN 5.0 Projects to your 
Repository. 
PeopleSoft eWay User’s Guide 16 Sun Microsystems, Inc.
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2 From the Project Explorer, right-click your Repository and select Export from the 
shortcut menu. The Export Manager appears.

3 From the Select Projects from the list field of the Export Manager, select one or 
more Projects that you want to export and move them to the Selected Projects field 
by clicking the Add to Select Items (arrow) button, or click All to include all of 
your Projects.

4 In the same manner, from the Select Environments from the list field, select the 
Environments that you want to export and move them to the Selected 
Environments field by clicking the Add to Select Items (arrow) button, or click All 
to include all of your Environments.

5 Browse to select a destination for your Project ZIP file and enter a name for your 
Project in the ZIP file field.

6 Click Export to create the Project ZIP file in the selected destination.

Install Sun Java Composite Application Platform Suite

7 Install Sun Java Composite Application Platform Suite, including all eWays, 
libraries, and other components used by your ICAN 5.0 Projects. 

8 Start the Sun SeeBeyond Enterprise Designer. 

Import the Project 

9 From the Enterprise Designer’s Project Explorer, right-click the Repository and 
select Import Project from the shortcut menu. The Import Manager appears.

10 Browse to and select your exported Project file. 

11 Click Import. A warning message, “Missing APIs from Target Repository,” may 
appear at this time. This occurs because various product APIs were installed on the 
ICAN 5.0 Repository, when the Project was created, that are not installed on the Sun 
Java Composite Application Platform Suite Repository. These APIs may or may not 
apply to your Projects. You can ignore this message if you have already installed all 
of the components that correspond to your Projects. Click Continue to resume the 
Project import.

12 Close the Import Manager after the Project is successfully imported.

Deploy the Project

13 You must create a new Deployment Profile for each of your imported Projects. 
When you export a Project, the Project’s components are automatically “checked in” 
to Version Control to write-protect each component. These protected components 
appear in the Explorer tree with a red padlock in the bottom-left corner of each icon. 
Before you can deploy the imported Project, the Project’s components must first be 
“checked out” of Version Control from both the Project Explorer and the 
Environment Explorer. To “check out” all of the Project’s components, do the 
following:

A From the Project Explorer, right-click the Project and select Version Control > 
Check Out from the shortcut menu. The Version Control - Check Out dialog box 
appears.

B Select Recurse Project to specify all components, and click Check Out. 
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C Select the Environment Explorer tab, and from the Environment Explorer, right-
click the Project’s Environment and select Version Control > Check Out from 
the shortcut menu.

D Select Recurse Environment to specify all components, and click Check Out.

14 If your imported Projects include File eWays, they must be reconfigured in your 
Environment prior to deploying the Project. To reconfigure your File eWays, do the 
following:

A The Environment File External System properties can now accommodate both 
inbound and outbound eWays. If your previous Environment includes both 
inbound and outbound File External Systems, delete one of these (for example, 
the outbound File External System).

B From the Environment Explorer tree, right-click your remaining File External 
System, and select Properties from the shortcut menu. The Properties Editor 
appears.

C The Directory property has been relocated from the Connectivity Map 
Properties to the Environment Properties. Set the inbound and outbound 
Directory values, and click OK.

15 Deploy your Projects.

Note:  Only Projects developed on 5.0.2 and above can be imported and migrated 
successfully into the Java Integration Suite.
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Chapter 3

Configuring the eWay Properties

This chapter describes how to configure the PeopleSoft eWay properties, and provides a 
list of the eWay properties and their required values.

What’s in This Chapter

Configuring the PeopleSoft eWay on page 19

PeopleSoft HTTP Client Connectivity Map Properties on page 23

PeopleSoft HTTP Server Connectivity Map Properties on page 24

PeopleSoft HTTP Client eWay Environment Properties on page 25

3.1 Configuring the PeopleSoft eWay
The PeopleSoft eWay includes two component eWays:

PeopleSoft HTTP Client eWay: The PeopleSoft HTTP Client eWay includes both 
Connectivity Map and Environment properties and must be configured from both 
locations.

PeopleSoft HTTP Server eWay: The PeopleSoft HTTP Server eWay includes only 
Connectivity Map properties. There are no Environment properties.

Once a component eWays and the Environment (with the external systems) have been 
created, the properties can be modified for your specific system.

3.1.1 Selecting PeopleSoft HTTP Client or PeopleSoft HTTP Server 
as the External Application

To create a PeopleSoft HTTP Client eWay you must first create a PeopleSoft HTTP 
Client External Application in your Connectivity Map. PeopleSoft HTTP Client eWays 
are located between a PeopleSoft HTTP Client External Application and a Service. 
Services are containers for Java Collaborations, Business Processes, eTL processes, and 
so forth.

To create a PeopleSoft External Application

1 From the Connectivity Map toolbar, click the External Applications icon. 
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Figure 1   External Applications Selection Menu

2 Select the PeopleSoft HTTP Client External Application from the menu (see 
Figure 1). The selected PeopleSoft HTTP Client External Application icon appears 
on the Connectivity Map toolbar. The PeopleSoft HTTP Server External Application 
is similarly created.

3.1.2 Accessing the eWay Properties
When you connect an External Application to a Collaboration, the Enterprise Designer 
automatically assigns the appropriate eWay to the link (see Figure 2). Each eWay is 
supplied with a template containing it’s default configuration properties, accessible 
from the Connectivity Map and/or the Environment Explorer tree.

Figure 2   Connectivity Map with Components

Modifying the eWay Connectivity Map Properties

The properties accessed from the Connectivity Map commonly apply to a specific 
component eWay, and may vary from other eWays (of the same type) in the Project.

1 From the Connectivity Map, double click the eWay icon located in the link between 
the associated External Application and the Service. 

2 The eWay Properties Editor opens displaying the eWay’s default Connectivity Map 
properties. Make any necessary modifications and click OK to save the settings.

Modifying the eWay Environment Properties

These properties (Environment) are commonly global, applying to all eWays (of the 
same type) in the Project. The saved properties are shared by all eWays for the specified 
External System.

1 From the Environment Explorer tree, right-click the Sun Java System AppServer 
External System. Select Properties from the shortcut menu. The Properties Editor 
opens with the Sun AppServer eWay Environment properties.

PeopleSoft HTTP
Client eWay
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2 Make any necessary modifications to the Environment properties, and click OK to 
save the settings.

3.1.3 Using the Properties Editor 
The Properties Editor displays the eWay’s configuration template and allows you to 
modify and save an eWays default property configuration.

Modifying the Default eWay Properties

1 From the upper-left pane of the Properties Editor, select a subdirectory of the 
Properties tree. The parameters contained in that subdirectory are now displayed in 
the right pane of the Properties Editor. For example, select the PeopleSoft Settings 
> PeopleTools 8.42 Settings subdirectory in the Properties tree. The PeopleTools 
8.42 Settings section’s editable parameters are now displayed in the Properties 
pane, as shown in Figure 3

Figure 3   Properties Editor - PeopleSoft HTTP Client eWay

2 Click on any property field to make it editable. For example, click on the 
DestinationNode property to edit the setting. For this property, you can type the 
value into the field. If a property value requires is true/false or multiple choice, the 
field reveals a submenu of property options. 

Click on the ellipsis (. . .) in the properties field (displayed when you click on the 
field). A separate configuration dialog box appears. This is helpful for large values 
that cannot be fully displayed in the parameter’s property field. Enter the property 
value in the dialog box and click OK. The value now appears in the property field.
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3 A description of each parameter is displayed in the Description pane when that 
parameter is selected. This provides a short description of the property and the 
required values.

4 The Comments pane provides an log area to enter any information about the 
currently selected parameter that you may want to save. Your entries are saved 
automatically for future referral.

5 Click OK to close the Properties Editor and save the changes. 

3.2 PeopleSoft eWay Properties
The PeopleSoft eWay properties are organized into the following sections:

PeopleSoft HTTP Client Connectivity Map Properties on page 23

PeopleSoft HTTP Server Connectivity Map Properties on page 24

PeopleSoft HTTP Client Connectivity Map Properties on page 23
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3.3 PeopleSoft HTTP Client Connectivity Map Properties
The PeopleSoft HTTP Client eWay properties, accessed from the Connectivity Map, are 
organized into the following sections:

HTTP Settings on page 23 

Note: SSL and proxy configurations (HTTPS) are not supported in this release.

3.3.1 HTTP Settings
The HTTP Settings section of the PeopleSoft HTTP Client eWay Connectivity Map 
properties contains the top-level parameters displayed in Table 6.

Caution: Calling the clear() method in the Collaboration Editor clears all HTTP properties. 
Once the properties have been cleared, you must manually rebuild the header and 
payload sections of the Request message in the Transformation Designer.

Table 6   Connectivity Map - HTTP Settings

Name Description Required Value

Allow cookies Specifies whether cookies sent from 
servers are allowed to be stored and sent 
on subsequent requests. If cookies are not 
allowed, sessions are not supported.

True or False. True indicates that 
cookies sent from the server are 
allowed. False indicates that 
Cookies are not accepted.

The configured default is True.

Accept type Specifies the default Accept-Type header 
value included when a request is sent to 
the server; for example, text/html, text/
plain, text/xml. 

An Accept-type header value. 

The configured default is text/
xml.
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3.4 PeopleSoft HTTP Server Connectivity Map Properties
The PeopleSoft HTTP Server eWay properties, accessed from the Connectivity Map, are 
organized into the following sections:

HTTP Server External Configuration on page 24 

Note: The PeopleSoft HTTP Server eWay does not possess Environment properties. 

3.4.1 HTTP Server External Configuration
The HTTP Server External Configuration section of the PeopleSoft HTTP Server eWay 
Connectivity Map properties contains the top-level parameters displayed in Table 6.

Table 7   Connectivity Map - HTTP Server External Configuration

Name Description Required Value

servlet-url Specifies the last path component of the HTTP server servlet URL. 
This URL is the one the client uses to access the server. The 
property value must be the servlet name, for example: 
HttpServerServlet. The total URL is made up of several 
components, including the Project deployment name and the 
value entered for this property. 

The servlet name must match the Primary URL property on the 
PeopleSoft server as described in Configuring the Connector to 
Post to eGate using HTTP on page 41.
For example, a complete servlet URL appears as follows:

http://<yourmachinename>:18001/
<yourdeploymentname>_servlet_<servletname>/<servletname>

Where:

yourmachinename is the name of the machine where your 
current Logical Host is running.

18001 is the port number specified as the connector port in the 
Integration Server properties (IS Configurations > Sections > 
Web Container Configuration > Web Server Configurations > 
Default Web Server > Connector Port).

yourdeploymentname is the name of your current Project’s 
Deployment Profile concatenated with _servlet.

servletname is the name of the PeopleSoft servlet. This is the 
value needed for this property.

Note: The servlet-url parameter does not support LDAP 
values.

Enter the name 
of the 
PeopleSoft 
Servlet. This is 
the last path 
component of 
the HTTP server 
servlet URL. 
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3.5 PeopleSoft HTTP Client eWay Environment Properties
The PeopleSoft HTTP Client eWay properties, accessed from the Environment Explorer 
tree, are organized into the following sections:

HTTP Settings on page 25

Proxy configuration on page 27

Security > Authentication on page 28

Security > SSL on page 29

PeopleSoft Settings on page 31

PeopleSoft Settings > PeopleTools 8.42 Settings on page 32

PeopleSoft Settings > PeopleTools 8.13 Settings on page 34

3.5.1 HTTP Settings
The HTTP Settings section of the PeopleSoft HTTP Client eWay Environment 
properties contains the top-level parameters displayed in Table 8.
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Table 8   Environment - HTTP Settings

Name Description Required Value

URL Specifies the default URL used to establishing an HTTP 
connection.
eGate uses the PeopleSoft eWay to send an HTTP post 
request to PeopleSoft’s HTTP listening connector. The 
PeopleSoft HTTP listening connector monitors specific ports 
for incoming HTTP messages. It is implemented as a Java 
HTTPServlet object running inside WebLogic's application 
server.

For PeopleTools 8.13, use the following:
Apache: http://PSFTHOST/servlets/
psft.pt8.gateway.
Gatewayservlet

WebLogic: 
http://PSFTHOST/servlets/gateway

For PeopleTools 8.42, use: http://PSFTHOST:90/
PSIGW/HttpListeningConnector

where PSFTHOST is the PeopleSoft server host name.

You can verify the 8.42 HTTP listening connector servlet by 
verifying the web.xml as described in “Verifying the HTTP 
Listening Connector” on page 45.

Note: The URL parameter does not support LDAP 
values.

The default URL used 
for establishing an HTTP 
connection.

Content 
type

Specifies the default Content-Type header value to include 
when sending a request to the server. 

The default Content-
Type header value. 

The configured default 
is:
text/xml; 
charset=iso_8859-1

Encoding Specifies the default encoding used when reading or writing 
textual data.

The default encoding 
used when reading or 
writing textual data. 

The configured default 
is ASCII.
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3.5.2 Proxy configuration
The Proxy configuration section of the PeopleSoft HTTP Client eWay Environment 
properties contains the top-level parameters displayed in Table 9.

Table 9   Environment - Proxy configuration

Name Description Required Value

Proxy host Specifies the hostname of the HTTP proxy 
server.

The hostname (string) of the 
HTTP proxy server.

Proxy port Specifies the port of the HTTP proxy host. The port number of the HTTP 
proxy server. The configured 
default is 8080.

Proxy username Specifies the username for accessing the 
HTTP proxy server.

A user name (login) for the 
HTTP proxy server.

Proxy password Specifies the password required for 
accessing the HTTP proxy host.

A password for the HTTP proxy 
server.
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3.5.3 Security > Authentication
The Security > Authentication section of the PeopleSoft HTTP Client eWay 
Environment properties contains the top-level parameters displayed in Table 10.

Table 10   Environment - Security > Authentication

Name Description Required Value

Http username Specifies the username used to authenticate 
the Web site specified by the URL.

A user name with access 
permission.

Http password Specifies the password used to authenticate 
the Web site specified by the URL.

A password linked to the user 
name.
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3.5.4 Security > SSL
The Security > SSL section of the PeopleSoft HTTP Client eWay Environment 
properties contains the top-level parameters displayed in Table 11.

Note: SSL is not currently supported for the PeopleSoft eWay. This section is reserved for 
future product enhancement.

Table 11   Environment - Security > SSL

Name Description Required Value

Protocol SSL Specifies the Secure Sockets Layer (SSL) 
or Transport Layer Security (TLS) 
protocol used when establishing an SSL 
connection with the server.

Select the appropriate protocol. The 
options are:

No SSL
TLS
TLSv1
SSLv3
SSLv2
SSL

The configured default is No SSL

JSSE Provider 
Class

Specifies the fully qualified name of the 
JSSE provider class.

The name of the JSSE provider class. 

The configured default value is 
com.sun.net.ssl.internal.ssl.Provider.

X509 Algorithm 
Name

Specifies the X509 algorithm name to 
use for the trust and key manager 
factories.

The X509 algorithm name to use for 
the trust and key manager factories.

The configured default is SunX509

Verify hostname Specifies whether hostname 
verification is done on the server 
certificate during the SSL handshake.

True or False. True indicates that 
hostname verification is performed 
on the server certificate during the 
SSL handshake. 

The configured default is False.

KeyStore type Specifies the keystore type for the 
keystore used for key/certificate 
management when establishing SSL 
connections.

The keystore type. The configured 
default is JKS.

KeyStore Specifies the keystore used for key/
certificate management when 
establishing SSL connections.

The keystore used for key/certificate 
management.

Keystore 
username

Specifies a username for accessing the 
keystore used for key/certificate 
management when establishing SSL 
connections.

A user name (login) with permission 
to access the keystore.
PeopleSoft eWay User’s Guide 29 Sun Microsystems, Inc.



Chapter 3 Section 3.5
Configuring the eWay Properties PeopleSoft HTTP Client eWay Environment Properties
Keystore 
password

Specifies the password for accessing 
the keystore used for key/certificate 
management when establishing SSL 
connections.

A password associated with the 
KeyStore username to access the 
keystore.

TrustStore type Specifies the truststore type of the 
truststore used for CA certificate 
management when establishing SSL 
connections.

The truststore type. 

The configured default is JKS.

TrustStore Specifies the truststore used for CA 
certificate management when 
establishing SSL connections. 

The name of the truststore.

TrustStore 
password

Specifies the password for accessing 
the truststore used for CA certificate 
management when establishing SSL 
connections.

A password that permits access to the 
truststore.

Table 11   Environment - Security > SSL (Continued)

Name Description Required Value
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3.5.5 PeopleSoft Settings
The PeopleSoft Settings section of the PeopleSoft HTTP Client eWay Environment 
properties contains the top-level parameters displayed in Table 12.

These settings must match the PeopleSoft server configurations as described in 
“Configuring the PeopleSoft Server for the PeopleSoft eWay Projects” on page 36.

Table 12   Environment - PeopleSoft Settings

Name Description Required Value

PeopleTools 
Version

Specifies the version of PeopleTools 
installed. The value options are:

8.42: PeopleTools version 8.42

8.13: PeopleTools version 8.13

Select 8.13 or 8.42. 

The configured default is 8.42.
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3.5.6 PeopleSoft Settings > PeopleTools 8.42 Settings
The PeopleSoft Settings > PeopleTools 8.42 Settings section of the PeopleSoft HTTP 
Client eWay Environment properties contains the top-level parameters displayed in 
Table 13.

The PeopleTools settings must match the configurations for the PeopleSoft server 
described in “Configuring PeopleTools 8.42” on page 37.

At minimum, you must specify the following properties:

MessageName on page 32

DestinationNode on page 32

RequestingNode on page 32

MessageVersion on page 32

Table 13   Environment - PeopleSoft Settings > PeopleTools 8.42 Settings

Name Description Required Value

MessageName Specifies the name of the message. The name of the message.

MessageType Specifies the type of message being 
sent. The type options are:

sync: Synchronous message

async: Asynchronous message

ping: Ping message

Select sync, async, or ping.

RequestingNode Specifies the name of the node sending 
the request.

The name of the node sending the 
request.

DestinationNode Specifies the name of the node that 
receives the message. This parameter is 
optional when you specified a default 
target node using the Default 
Application Server Jolt connect string 
properties in the 
integrationGateway.properties file.

The name of the node that receives 
the message.

FinalDestination Specifies the name of the node that 
ultimately receives the message. This is 
common when a PeopleSoft 
Integration Broker hub is used.

The name of the node that ultimately 
receives the message.

MessageVersion Specifies the message version. The message version.

NonRepudiation Specifies whether the message content 
in the request should be processed 
using nonrepudiation logic.

True or False. True indicates that 
nonrepudiation logic will be used to 
process the message content of the 
request.

OrigNode Specifies the name of the node that 
started the process. This property is 
optional.

The name of the node that started 
the process.
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OrigProcess Specifies the originating process by 
which the message was initially 
generated. 

The originating process by which the 
message was initially generated.

OrigUser Specifies the user ID for the user from 
which the message was initially 
generated.

This property is optional.

The user ID for the user from which 
the message was initially generated.

Password Specifies the password as entered in 
the target node's definition for the 
source node. The target node 
authenticates the password when it 
receives the message. 

This parameter is only required if 
password authentication is enabled for 
the source node definition in the target 
database.

The password, as it is presented in 
the target node's definition for the 
source node.

Table 13   Environment - PeopleSoft Settings > PeopleTools 8.42 Settings (Continued)

Name Description Required Value
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3.5.7 PeopleSoft Settings > PeopleTools 8.13 Settings
The PeopleSoft Settings > PeopleTools 8.13 Settings section of the PeopleSoft HTTP 
Client eWay Environment properties contains the top-level parameters displayed in 
Table 14.

The PeopleTools settings must match the configurations for the PeopleSoft server 
described in “Configuring PeopleTools 8.13” on page 52.

At minimum, you must specify the following properties:

MessageVersion on page 34

FromNode on page 34

ToNode on page 34

Channel on page 34

PublicationProcess on page 34

Subject on page 35

Table 14   Environment - PeopleSoft Settings > PeopleTools 8.13 Settings

Name Description Required Value

MessageVersion Specifies the message version. The message version.

ToNode Specifies the name of the node for which the 
message is intended. This must correspond to an 
entry in the node lookup table on the gateway 
servlet, and the name of the local node (node 
definition) on the receiving PeopleSoft system.

The name of the node 
for which the message 
is intended. 

FromNode Specifies the name of the node from which 
messages originate. The node name must match 
the node definition for the third party system as 
defined in the receiving PeopleSoft system.

The name of the node 
from which the 
messages originate.

Channel Specifies the name of the message channel 
containing the message.

The name of the 
message channel.

PublicationProcess Specifies the application-defined name of the 
program that generated the message. This may be 
required by the application.

The application-
defined name of the 
program that 
generated the 
message. 

Password Specifies the password associated with the 
destination node. 

This value is stored in the PeopleSoft database and 
must be communicated to the system 
administrators for the publishing system. If the 
node definition on the sending system has a node 
group defined, the password will be present. If the 
node definition on the receiving system has a node 
group defined, the password must be present and 
must match the node group password.

The password 
associated with the 
destination node.
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DefaultDataVersion Specifies the default message version for the 
sending system.

The default message 
version.

OriginatingNode Specifies the name of the node that originally 
published the message. This property is used to 
prevent circular publishing. If not in the XML file, 
the system sets it to the publishing node name.

The name of the node 
that originally 
published the 
message.

PublicationID Specifies the system generated identifier for the 
publication.

The fields, FromNode, Channel, and PublicationID, 
uniquely identify the publication. If the FromNode 
is specified and the Publication ID is omitted, the 
publication ID is set to the next available 
publication ID on that channel within the 
subscribing PeopleSoft database.

The system generated 
identifier for the 
publication.

Publisher Specifies the application-defined operator ID class 
that published the message. This may be required 
by the application.

The application-
defined operator ID 
class that published 
the message.

SubChannel Specifies the name of the subchannel that contains 
the message. 

Messages in the same channel, but in different 
subchannels, are assumed to refer to distinct 
objects (for example, different POs or different 
employees), and are processed in parallel if 
possible. This field contains the concatenated 
values that represent the subchannel. For example, 
if the subchannel is Business Unit, Journal ID, then 
the value of this field is M04123456789 where 
Business Unit = M04 and Journal ID = 123456789. 
Include this field if the subscribing PeopleSoft 
system has a defined subchannel, otherwise, it may 
be omitted.

The name of the 
subchannel that 
contains the message. 
See the description for 
the naming format.

Subject Specifies the name of the message as defined in the 
PeopleSoft system.

The name of the 
message as defined in 
the PeopleSoft system.

SubjectDetail Specifies the application defined subtype of the 
message name.

The application 
defined subtype of the 
message name.

Table 14   Environment - PeopleSoft Settings > PeopleTools 8.13 Settings (Continued)

Name Description Required Value
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Chapter 4

Configuring the PeopleSoft Server for the 
PeopleSoft eWay Projects

For the PeopleSoft eWay to communicate with PeopleSoft servers, the PeopleSoft 
Integration Gateway must be configured for eGate postings as described in this chapter.

What’s in This Chapter

Overview on page 36

Configuring PeopleTools 8.42 on page 37

Configuring PeopleTools 8.13 on page 52

4.1 Overview
For the Sun Java Composite Application Platform Suite to post and receive messages 
from PeopleSoft, you must configure the PeopleSoft server. The configurations are 
different for PeopleTools 8.13 and 8.42. For PeopleTools 8.42, there are also different 
configurations depending on whether the PeopleSoft eWay Project uses JMS, HTTP, or 
both. Table 15 summarizes the different configurations.

The sections below describe how to configure PeopleSoft servers to communicate with 
the PeopleSoft eWay using PeopleTools 8.42 or 8.13. Information about the PeopleSoft 
server can be found in the PeopleBooks documentation provided by PeopleSoft.

Table 15   

Version JMS HTTP

PeopleTools 8.42 Source node
Target node
.bindings file
IntegrationGateway.properties

Source node
Target node
HTTP listening connector
HTTP publication handler

PeopleTools 8.13 n/a PeopleSoft message node
HTTP message node
Message channel inbound
Message channel outbound
PeopleSoft subscription handler
HTTP publication handler
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4.2 Configuring PeopleTools 8.42
This section describes how to configure PeopleTools 8.42 to integrate using the Sun Java 
Composite Application Platform Suite. When you use this version of PeopleTools, you 
can create the PeopleSoft eWay Projects that use inbound and outbound JMS data 
flows, and inbound HTTP data flows. Inbound HTTP data flows are only supported 
when you use an eInsight implementation of the eWay.

4.2.1 Configuring PeopleSoft for eGate Posting
The following section describes how to create PeopleSoft nodes to receive and post 
messages with the Sun Java Composite Application Platform Suite.

Creating Source Nodes to Receive eGate Posts

The procedure below describes how to set up the PeopleSoft node to receive eGate 
messages.

1 Log into the PeopleSoft server.

2 Follow the PeopleSoft documentation to create a new node and configure it as 
shown in Figure 4.

Figure 4   Adding the Node to Receive eGate Posts

3 Add a transaction for the eGate post using your own naming convention and 
configure it as displayed in Figure 5 on page 38.
PeopleSoft eWay User’s Guide 37 Sun Microsystems, Inc.



Chapter 4 Section 4.2
Configuring the PeopleSoft Server for the PeopleSoft eWay Projects Configuring PeopleTools 8.42
Figure 5   Adding the Transaction to Receive eGate Posts

4 Click Edit. The Transaction Detail tab appears. Configure the transaction as shown 
in Figure 6.

Figure 6   Configuring the Transaction to Receive eGate Posts

5 Click Messages. From the Messages tab, configure the messages for the eGate post 
as shown in Figure 7 on page 39.
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Figure 7   Configuring the Messages to Receive eGate Posts

Activating Message Channels to Receive eGate Messages

Each channel must be defined and activated before the eWay can post any data. The 
procedure below describes how to activate the message channels for subscription to the 
PeopleSoft eWay.

To activate message channels to receive eGate HTTP posts

1 From the PeopleSoft Application Designer, create a channel. You can use the default 
properties.

2 Create the request and response message definitions. These message do not require 
PeopleCode.

3 Click Message Properties. The Message Properties dialog box appears.

4 Select the Active option and click OK (see Figure 8 on page 40).
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Figure 8   Activating Message Channels

Creating Target Nodes to Post Messages to eGate Using HTTP

The procedure below describes how to create and configure PeopleSoft nodes to post 
messages to eGate using HTTP.

To create target nodes to post messages to eGate using HTTP 

1 Follow the PeopleSoft documentation to create a new node using your own naming 
convention and configure it as displayed in Figure 9.

Figure 9   Creating Nodes to Post to eGate
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2 Select the target connector ID. From the Connectors tab, enter the values displayed 
in Figure 10.

Figure 10   Configuring the Connector to Post to eGate using HTTP

Use the following format for the PRIMARYURL property:

http://<yourmachinename>:18001/
<yourdeploymentname>_servlet_<servletname>/<servletname>

This property must match the logical eWay Servlet-url property defined in the 
Enterprise Designer as described in “servlet-url” on page 24. The port number 
must match the default Web server port number specified in the Integration Server 
properties in the Enterprise Designer. The Deployment Profile is the name of the 
Project’s Deployment Profile defined in the Enterprise Designer. The Deployment 
Profile name must be followed by _servlet_servletname.

3 Configure the transaction as displayed in Figure 11 on page 42).
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Figure 11   Configuring the Transaction to Post to eGate using HTTP

4 Click Edit (see Figure 12).

Figure 12   Configuring the Transaction Detail to Post to eGate Using HTTP

5 Click Messages. The Messages tab is displayed (see Figure 13 on page 43).
PeopleSoft eWay User’s Guide 42 Sun Microsystems, Inc.



Chapter 4 Section 4.2
Configuring the PeopleSoft Server for the PeopleSoft eWay Projects Configuring PeopleTools 8.42
Figure 13   Configuring the Messages to Post to eGate Using HTTP

Creating Target Nodes to Post to eGate Using JMS

After creating the source node in PeopleTools, follow the procedure below to create the 
JMS target node.

To create the target Node to post to eGate using JMS

1 Follow the PeopleSoft documentation to create a new node using your own naming 
convention and configure it as displayed in Figure 14.
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Figure 14   Creating Nodes to Post to eGate Using JMS

2 Select the target connector ID, and enter the values shown in Figure 15.

Figure 15   Configuring the Connectors to Post to eGate Using JMS
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The JMS properties, such as persistence and acknowledgement modes, must match the 
settings for the JMS client as defined from the Connectivity Map. For information about 
JMS properties, refer to the Sun SeeBeyond eGate™ Integrator JMS Reference Guide.

The JMSQueue or JMSTopic property must match the name of the queue/topic in the 
Connectivity Map. The target destination must match the incoming queue/topic, and 
the source destination must match the outgoing queue/topic.

The JMSFactory property must point to the topic or queue ConnectionFactory for the 
topic or queue properties in the JNDI bindings file.

The JMSUrl property must point to your JNDI bindings file (see “Creating the JNDI 
Bindings File for JMS Posting” on page 49).

Make sure that the node that uses JMSTargetConnector as the connector is setup 
correctly in regard to the, JMSUserName, JMSPassword. 

4.2.2 Additional HTTP Configurations

Verifying the HTTP Listening Connector

Two types of HTTP connectors are used with PeopleSoft eWay Projects that use HTTP 
to communicate to PeopleSoft: the HTTP listening connector and the HTTP target 
connector. 

The PeopleSoft server uses the HTTP listening connector to receive messages from. The 
PeopleSoft eWay HTTP client external application is used to post to the HTTP listening 
connector. You do not have to configure the HTTP listening connector; the connector is 
started automatically by the PeopleSoft Integration Application.

However, you must set the location for the HTTP listening connector in the 
Environment properties of the PeopleSoft eWay as described in “URL” on page 26. The 
routing of messages in the PeopleSoft server is decided by the content of the message in 
the header section.

The HTTP target connector is used to send HTTP messages to eGate. The eGate 
component receiving the HTTP message is a servlet. The servlet name is specified in the 
Connectivity Map as described in “servlet-url” on page 24.

To verify HTTP listening connector

1 In a text editor, open the web.xml file in the following directory:

bea\wlserv6.1\config\peoplesoft\applications\PSIGN\WEB-INF

where bea is the WebLogic installation directory.

2 Verify that the following section is included, and add it if it is absent (see Figure 16).
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Figure 16   Verifying the HTTP Listening Connector

4.2.3 Additional JMS Configurations

Configuring Inbound JMS Connections

To configure inbound JMS connections, you must edit the 
IntegrationGateway.properties file as described in the procedure below.

To configure inbound JMS connections

1 Open the IntegrationGateWay.properties file from the following directory:

bea\wlserver6.1\config\peoplesoft\applications\PSIGW\WEB-INF

where bea is the WebLogic installation directory.

2 Edit the file for the JMS queue listener properties as shown in Table 16.

You can configure multiple queues by using the convention ig.jms.queue1, 
ig.jms.queue2, ig.jms.queue3, and so on. Table 16 shows how the JMS listener is 
configured for the GenericOutQueue.

Table 16   JMS Queue Listener Properties
ig.jms.Queues=1 “1” indicates only one queue.
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ig.jms.Queue1=GenericOu
tQueue

The first queue name “GenericOutQueue”, must be the same in the 
.bindings file. The Java code used to generate the entry in the 
.bindings is: 
queue = new STCQueue("GenericOutQueue");
q = null;
  try {
          q = (Queue)   
         jndifContext.lookup("GenericOutQueue");             
System.out.println(q.getClass().getName());
            } catch (Exception e) {
                 System.out.println("fcontext GenericOutQueue lookup 
exception");
                e.printStackTrace();
            }
            if (q == null) {
                System.out.println("q is null...bind GenericOutQueue as 
GenericOutQueue");              
                jndifContext.bind("GenericOutQueue", queue);
            }

ig.jms.Queue1.Provider=Su
nSeeBeyond

The “SunSeeBeyond” entry must match the configuration entry in 
the integrationgateway.properties file:
ig.jms.JMSProvider.JNDIFactory.SeeBeyond=com.sun.jndi.fscontext.
RefFSContextFactory

ig.jms.Queue1.JMSFactory=
QueueConnectionFactory

“QueueConnectionFactory” is the JNDI name in the .bindings file. 
Use the following Java code to generate the entry:

QueueConnectionFactory tgtqcf  = null;
            try {
                /*you can change the jndi name here, the jndi name use here 
must be exactly same
                 *as in the websphere's Generic JMS Provider's configuration 
External JNDI Name
                 */
                tgtqcf = (QueueConnectionFactory) 
jndifContext.lookup("QueueConnectionFactory");
            } catch (Throwable e) {
                System.out.println("fcontext QueueConnectionFactory 
lookup exception");
                e.printStackTrace();
            }
            if (tgtqcf == null) {
                System.out.println("fcontext QueueConnectionFactory 
lookup is null...");
                
                jndifContext.bind("QueueConnectionFactory", srcqcf);
            } else {
                System.out.println("fcontext QueueConnectionFactory is 
NOT null...unbind then re-bind QueueConnectionFactory");
                
                jndifContext.unbind("QueueConnectionFactory");
                jndifContext.rebind("QueueConnectionFactory", srcqcf);
            }
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3 Edit the file for the JMS queue listener properties as shown in Table 17.

You can configure multiple queues by using the convention ig.topic1, ig.topic2, 
ig.topic3, and so on. Table 17 shows how to configure the JMS topic to use the 
GenericOutTopic.

Table 17   JMS Queue Listener Properties

ig.jms.Queue1.MessageSel
ector=

see the Sun SeeBeyond eGate™ JMS Reference Guide.

ig.jms.Queue1.Url=file:c:/
jndibindings/

The URL of the .bindings file. Because PeopleSoft only supports 
fcontext, this is a directory name.

ig.jms.Queue1.User=Admi
nistrator

User name to eGate JMS server.

ig.jms.Queue1.Password=S
wBAuVVABok=

Encrypted value of the password to eGate JMS server. Use the 
PeopleSoft utility pscipher to get the encrypted value.

ig.jms.Topics=1 “1” indicates only one topic.

ig.jms.Topic1=GenericOutTopic The first topic name “GenericOutTopic”, must be the 
same in the .bindings file. The Java code to generate this 
entry in the .bindings is:
topic = new STCTopic("GenericOutTopic");
            t = null;
            try {
                /*you can change the jndi name here, the jndi 
name use here must be exactly same
                 *as in the websphere's Generic JMS Provider's 
configuration External JNDI Name
                 */
                t = (Topic) 
jndifContext.lookup("GenericOutTopic");
                System.out.println(t.getClass().getName());
            } catch (Exception e) {
                 System.out.println("fcontext GenericOutTopic 
lookup exception");
                e.printStackTrace();
            }
            if (t == null) {
                System.out.println("t is null...bind 
GenericOutTopic as GenericOutTopic");
                
                jndifContext.bind("GenericOutTopic", topic);
            }

ig.jms.Topic1.Provider=SunSee
Beyond

The “SunSeeBeyond” entry must match the 
configuration entry in the integrationgateway.properties 
file:
ig.jms.JMSProvider.JNDIFactory.SeeBeyond=com.sun.jn
di.fscontext.RefFSContextFactory
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Creating the JNDI Bindings File for JMS Posting

To enable the PeopleSoft eWay to post to PeopleSoft using JMS, you must have a JNDI 
bindings file in place. You can generate the bindings file with any standard JNDI 
generation application. Sun provides a sample generation application called 
PSFTBindJMS.java. This program and two associate applications, compile.bat and 
run.bat, are included in the sample Project file.

ig.jms.Topic1.JMSFactory=Topic
ConnectionFactory

“TopicConnectionFactory” is the JNDI name in the 
.bindings file. Use the following Java code to generate 
the entry:
TopicConnectionFactory tgttcf  = null;
            
            try {
                /*you can change the JNDI name here, the JNDI 
name use here must be exactly same
                 *as in WebSphere's Generic JMS Provider's 
configuration External JNDI Name
                 */
                tgttcf = (TopicConnectionFactory) 
jndifContext.lookup("TopicConnectionFactory");
            } catch (Throwable e) {
                System.out.println("fcontext 
TopicConnectionFactory lookup exception");
                e.printStackTrace();
            }
            if (tgttcf == null) {
                System.out.println("fcontext 
TopicConnectionFactory lookup is null...");
                
                jndifContext.bind("TopicConnectionFactory", 
srctcf);
            } else {
                System.out.println("fcontext 
TopicConnectionFactory is NOT null...unbind then re-
bind TopicConnectionFactory");
                
                
jndifContext.unbind("TopicConnectionFactory");
                jndifContext.rebind("TopicConnectionFactory", 
srctcf);
            }

ig.jms.Topic1.MessageSelector= Refer to the queue table.

ig.jms.Topic1.Url=file:c:/
jndibindings/

Refer to the queue table.

ig.jms.Topic1.User=Administrat
or

Refer to the queue table.

ig.jms.Topic1.Password=SwBAu
VVABok=

Refer to the queue table.
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You must edit and recompile the PSFTBindJMS.java file before generating the 
bindings file. 

To create the JNDI bindings file, do the following:

1 Create the directory, C:\testprogram. Copy the PSFTBindJMS.java, compile.bat, 
and run.bat files to this directory.

Note: The latest version of the eGate API Kit JAR files must be added to the WebLogic 
PeopleSoft-PIS server classpath. To confirm this, check the JAR files in the server’s 
setENV.cmd file located in the following location (or equivalent): 

C:\bea\wlserver6.1\config\peoplesoft\setEnv.cmd

If you have installed the PeopleSoft-PIA service as a Windows Service, you must 
uninstall and reinstall the service by executing unInstallNTServicePIA.cmd first, 
then executing installNTServicePIA.cmd. This is a runtime classpath requirement 
to confirm the new classpath.

2 Open the PSFTBindJMS.java file in a text editor and follow the directions 
presented in the text of the file. Edit the JNDI bindings generation application with 
the eGate host name and location. Verify that the eGate JMS server port number is 
correct. This port number must match the Server port property for the JMS IQ 
Manager in the Enterprise Designer. For information, refer to the Sun SeeBeyond 
eGate™ JMS Reference Guide.

3 Modify the following line to point to your own directory:

fcontextprops.put(Context.PROVIDER_URL, 
"file:C:\\eGateExports\\PeopleSoft\\JMS");

Note: If you are installing the Sun Java Composite Application Platform Suite and the 
PeopleSoft eWay on a computer that previously included ICAN 5.0.5, be sure to 
delete all of the previously installed API JAR files, and follow the directions in the 
Sun SeeBeyond eGate API Kit Developer’s Guide to modify your classpath to 
include the new API JAR files.

4 Double-click compile.bat to compile the program. A class file is generated.

5 Double-click run.bat to run the program. This creates a .bindings file.

6 Copy the .bindings file to the location of the JMSUrl property described in the 
section above (see “Creating Target Nodes to Post to eGate Using JMS” on 
page 43. 

When you run the bindings generation application for the first time, the following 
feedback is displayed:

fcontext TopicConnectionFactory lookup exception, you never had 
this jndi entry
fcontext TopicConnectionFactory lookup is null... will bind to the 
jndi name
fcontext GenericInTopic lookup exception, it doesn't exist
GenericInTopic is null...bind GenericInTopic as GenericInTopic
fcontext GenericOutTopic lookup exception, it doesn't exist
GenericOutTopic is null...bind GenericOutTopic as GenericOutTopic
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fcontext ErrorTopic lookup exception, it doesn't exist
t is null...bind ErrorTopic as ErrorTopic
fcontext QueueConnectionFactory lookup exception it doesn't exist
fcontext QueueConnectionFactory lookup is null...bind with new 
value
fcontext GenericInQueue lookup exception, it doesn't exist
GenericInQueue is null...bind GenericInQueue as GenericInQueue
fcontext GenericOutQueue lookup exception
GenericOutQueue is null...bind GenericOutQueue as GenericOutQueue

In the subsequent runs, the following feedback is displayed:

fcontext TopicConnectionFactory is NOT null...unbind then re-bind 
TopicConnectionFactory will overwrite old value
com.stc.jms.client.STCTopic
fcontext GenericInTopic is NOT null...unbind then re-bind 
GenericInTopic will overwrite old value
com.stc.jms.client.STCTopic
fcontext GenericOutTopic is NOT null...unbind then re-bind 
GenericOutTopic will overwrite old value
com.stc.jms.client.STCTopic
fcontext ErrorTopic is NOT null...unbind then re-bind ErrorTopic 
will overwrite old value
fcontext QueueConnectionFactory is NOT null...unbind then re-bind 
QueueConnectionFactory
com.stc.jms.client.STCQueue
fcontext GenericInQueue is NOT null...unbind then re-bind 
GenericInQueue will overwrite old value
com.stc.jms.client.STCQueue
fcontext GenericOutQueue is NOT null...unbind then re-bind 
GenericOutQueue will overwrite old value

7 Once you have completed all of these steps, restart the PeopleSoft-PIA services. You 
can restart the PIA services from the Windows Services console, or you can restart 
the service from a Command Line using the following command:

startIA.cmd

After you execute this command, monitor the PIA_weblogic.log file until you see 
the following output:

#### <> <000329>

This indicates that the PIA Service is started. If you use this method of starting the 
PIA service, be aware that the Windows Services console will not accurately reflect 
that the service has been started.

8 Stop and restart the JMSListeningConnector using the URL (see “Starting and 
Stopping the JMS Listening Connector” on page 52). After you start the JMS 
Listening Connector, monitor the PIA_weblogic.log. The following message 
indicates that the JMS Listening Connector has started correctly:

#### <> <> <101047> <[WebAppServletContext(2244929,PSIGW,/PSIGW)] 
JMSListeningConnectorAdministrator: init>
#### <> <> <101047> <[WebAppServletContext(2244929,PSIGW,/PSIGW)] 
PeopleSoftListeningConnector: init>

If you perform step 8 before the PIA service is ready, the JMS Listening Connector 
will not be active, so it will not receive messages from eGate.
PeopleSoft eWay User’s Guide 51 Sun Microsystems, Inc.



Chapter 4 Section 4.3
Configuring the PeopleSoft Server for the PeopleSoft eWay Projects Configuring PeopleTools 8.13
Starting and Stopping the JMS Listening Connector

To start the JMS listening connector, use the following command:

http://hostname:port/PSIGW/
JMSListeningConnectorAdministrator?Activity=START

To stop the JMS listening connector, use the following command:

http://hostname:port/PSIGW/
JMSListeningConnectorAdministrator?Activity=STOP

Verifying the JMS Connection

To verify if your JMS connection works, you can use the StartSendMaster.bat provided 
by PeopleSoft in the following location:

c:\bea\wlserver6.1\config\peoplesoft\applications\PSIGW

4.2.4 Verifying PeopleSoft Server Logs
You can verify log information for the PeopleSoft server in the following directory:

bea\wlserver6.1\config\peoplesoft\applications\PSIGW

where bea is the installation directory where WebLogic is installed.

4.2.5 Notes on PeopleSoft Server Disconnections for JMS
If the Logical Host is shut down during a JMS session with PeopleSoft, the PeopleSoft 
server looses the session. You must reestablish the connection on the PeopleSoft server.

4.3 Configuring PeopleTools 8.13
This section describes how to configure PeopleTools 8.13 to integrate using the eGate 
Integrator. When you use this version of PeopleTools, you can create PeopleSoft eWay 
Projects that use inbound HTTP Collaborations. Outbound HTTP Collaborations are 
only supported when you use eInsight together with eGate.

4.3.1 Creating the PeopleSoft Node to Receive eGate HTTP Posts
The procedure below describes how to create and configure PeopleSoft nodes for eGate 
HTTP posting. 

To create PeopleSoft nodes to receive eGate HTTP posts

1 In the PeopleTools Application Designer, click New on the File menu. The New 
dialog box appears.

2 Click Message Node and click OK to display the Message Node dialog box for 
Node 1.
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3 Right-click the Locations pane and click Insert Location. The Location dialog box 
appears.

4 Enter the URL shown below for the PeopleSoft Gateway Servlet and click OK.

For Apache:

http://PSFTHOST/servlets/psft.pt8.gateway.GatewayServlet

For WebLogic:

http://PSFTHOST/servlets/gateway

where PSFTHOST is the name of the host computer where PeopleSoft runs.

The URL name displays in the Message Node dialog box similar to Figure 17.

Figure 17   PeopleSoft Node for Receiving eGate HTTP Posts

5 Click Save As on the File menu.

6 Enter the name of the message node.

7 From the File menu, click Open. The Open Object window appears (see Figure 18).

8 To verify that the message node is ready for use, select Message Node from the 
Object Type list and click Open 

A list of all message nodes displays as shown in the Figure 18. The name of the new 
message node appears in the Objects matching selection criteria pane.

Message nodes with PSFT prefixes are created by the PeopleSoft installation. PSFT_EP 
is the PeopleSoft local node for the Financials application. It is specified as a subscriber 
to messages sent from the PeopleSoft eWay, and a publisher of messages to the HTTP 
server. 

Figure 18   Viewing Message Nodes
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4.3.2 Activating the Message Definition to Receive eGate Posts
PeopleSoft comes with a set of predefined message definitions. The desired message 
definition is configurable in the eWay with the Subject property. The following 
instructions describe how to activate the message definition for subscription to the 
PeopleSoft eWay.

Note: For purposes of this publication the ADVANCED_SHIPPING_RECEIPT Message 
Definition is activated for publish / subscribe.

Each message used for publication must be defined. This definition corresponds to the 
XML message the eWay publishes, and contains the elements of the data to be 
published. However, before the eWay can publish any data, the message definition 
must be activated. The Application Designer includes a list of these definitions. 

To activate the message definition to receive eGate posts

1 In PeopleTools Application Designer, click Open on File menu. The Open Object 
dialog box appears.

2 Click Message from the Object Type list. This displays all available PeopleSoft 
message definitions (see Figure 19).

Figure 19   Viewing Available Message Destinations

3 Double-click the message definition. The Message window appears, displaying the 
record details of the chosen message structure as displayed in procedure on 
page 55.
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Figure 20   Message Structure Details

4 Click Object Properties on the File menu,. The Message Properties dialog box 
appears.

5 Click the Use tab.

6 Select the Active option as displayed in Figure 21, and click OK.

Figure 21   Activating the Message Definition to Receive eGate Posts

7 Save your current changes. You have now activated the message definition for 
publishing or subscribing.

4.3.3 Defining Message Channel Routing Rules
This procedure describes how to configure message channels. Before you start, 
determine which message channel you will use. You can configure the PeopleSoft eWay 
for this message channel with the Channel property.
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Configuring the Message Channel

Each message channel logically groups messages together. For purposes of the 
procedure below, the ADVANCED_SHIPPING_RECEIPT message is grouped into the 
ADVANCED_SHIPPING_NOTICE message channel. 

To configure the message channel

1 Log into the PeopleTools Application Designer.

2 Click Open on the File menu. The Open Object dialog box appears.

3 Select Message Channel from the Object Type list and click Open. This displays all 
available message channels.

4 Double-click the message channel to be used. The Message Channel window 
appears for that channel.

5 Click Routing Rules, right-click the pane, and from the shortcut menu, click Insert 
message node. The Insert Message Node dialog box appears, displaying the 
available message nodes.

6 Select PSFT_EP and click Insert. This inserts the message into the routing rules 
table.

7 Select STCPUBLISHER and click Insert.

8 Click Cancel to close the dialog box.

The message nodes are now defined on the Routing Rules tab of the Message 
Channel window as shown in Figure 22.

Figure 22   Viewing the Message Nodes
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Defining Routing Directions for Message Nodes

Routing directions provide you with the ability to assign destinations (Publish To/
Subscribe From) to a message node. This section describes the procedure for defining 
the routing directions for the eWay message node, Subscribe From.

To define the routing directions

1 In the Routing Rules Tab of Message Channel window in the Application 
Designer, right-click Both (Publish and Subscribe) for STCPUBLISHER, click 
Routing Direction, then Subscribe From.

2 Right-click Both (Publish and Subscribe) for PSFT_EP, click Routing Direction, 
and click Publish To.

The Routing Rules tab now shows that the eWay message node is subscribing to 
messages from PSFT_EP and is publishing to STCHTTP (see Figure 23).

Figure 23   Viewing Routing Directions

3 Click Save on the File menu. You have now defined the routing rule that allows the 
appropriate message to be published from the eWay to PeopleSoft.

4.3.4 Adding the PeopleSoft Subscription Handler
The procedure below describes how to add the PeopleSoft subscription handler. Before 
you start the procedure below, make a note of the following PeopleSoft configurations:

Jolt listener host

Jolt listener port

PeopleTools version

Operator ID

Operator ID password

To add the PeopleSoft handler directory

1 Navigate to the following URL in a browser to open the handler directory:

For Apache:

http://PSFTHOST/servlets/psft.pt8config.ConfigServlet

For WebLogic:

http://PSFTHOST/servlets/gateway.administration

where PSFTHOST is the host where the PeopleSoft Application Messaging 
Gateway is installed.
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The Handler Directory page appears (see Figure 24).

Figure 24   Adding the PeopleSoft Handler Directory

2 Click Add handler. The Add Handler page appears.

3 Enter the PeopleSoft handler class: 

psft.pt8.psfthandler.PeopleSoftHandler

as displayed in Figure 25 and click Save.

Figure 25   Viewing the New Handler

4 Click Load to load the PeopleSoft handler class you just added. The status changes 
to Loaded successfully.

5 Click Configure to configure the handler. The Manage Lookup Table page for the 
PeopleSoft handler appears (see Figure 26).

Figure 26   Managing the Lookup Table

6 Click Add a new node to associate the node with this subscription handler. The Add 
an address window appears (see Figure 27).

Figure 27   Adding an Address

7 Enter the values for the new node, PSFT_EP, associated with the subscription 
handler. These values are mandatory.

8 Click Save address. The Manage Lookup Table page now displays the new node as 
shown in Figure 28.
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Figure 28   Viewing the New Node

The Application Messaging Gateway is now ready to receive XML messages from 
the eWay and publish the XML messages to PeopleSoft. 

4.3.5 Configuring for Subscription 
To configure PeopleSoft to publish XML messages to the PeopleSoft eWay involves the 
following steps:

Creating an HTTP eWay Message node on page 59

Activating the Message Definition for Subscription on page 59

Defining the Message Channel Routing Rules on page 59

Adding the HTTP publication handler on page 59

4.3.6 Creating an HTTP eWay Message node
Refer to “Creating the PeopleSoft Node to Receive eGate HTTP Posts” on page 52 to 
create a message node associated with the PeopleSoft eWay. A message node called 
STCHTTP is used as an example.

4.3.7 Activating the Message Definition for Subscription
Refer to “Activating the Message Definition to Receive eGate Posts” on page 54 to 
activate the message to be published to the PeopleSoft eWay. In this case, activate the 
PO-EXPECTED_RECEIPT_SHIPTO message.

4.3.8 Defining the Message Channel Routing Rules
Refer to “Defining Message Channel Routing Rules” on page 55 to define the routing 
rules for the message channel to be used.

Insert the PSFT_EP message node and the HTTP message node previously created.

Define the routing direction. Select Subscribe From for PSFT_EP and Publish To for 
the HTTP message node (STCHTTP).

4.3.9 Adding the HTTP publication handler
This procedure describes how to add the HTTP publication handler. Before you start, 
verify that the HTTP publication handler is installed as described in “Installing the 
HTTP Publication Handler for PeopleTools 8.13” on page 15. Also, obtain the HTTP 
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configuration values for the eWay which is to receive the XML message(s) from 
PeopleSoft. These are required when configuring the message node corresponding to 
the subscription handler.

To obtain the HTTP configuration values

1 Navigate to the following URL in a browser to open the handler directory:

For Apache:

http://<yourmachinename>:18001/
<yourdeploymentname>_servlet_<servletname>/<servletname>.

For WebLogic:

http://<PSFTHOST>/servlets/gateway.administration

where <PSFTHOST> is the host where the PeopleSoft Application Messaging 
Gateway is installed.

The Handler Directory page appears (see Figure 29).

Figure 29   Adding the PeopleSoft Handler Directory

2 Click Add handler. The Add Handler page appears.

3 Enter the HTTP publication handler class as shown below and click Save.

com.stc.ewpsoft8.stchttphandler.HTTPHandler

4 Click Save. The Handler Directory page displays the new handler (see Figure 30).

Figure 30   Adding the PeopleSoft Handler Directory

5 Click Load. The status changes to Loaded successfully.

6 Click Configure for the HTTP handler. The HTTP Handler Directory page appears.

7 Click Add an HTTP node to associate a node with this subscription handler. 

8 Enter the values for the new node associated with the subscription handler. Scroll to 
the right to access additional columns.

9 In the Include Headers column, indicate whether or not you want header 
information to be retained in the received messages. All values are mandatory.
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A Selecting the check box preserves the header information.

B Deselecting the check box strips the header information.

10 Click Save. This displays the STCHTTP node entries. If the entries are correct, the 
Application Messaging Gateway now can receive XML messages from PeopleSoft 
and publish the XML messages to the PeopleSoft eWay (in HTTP mode).

You can now ping the HTTP host from the system where the 
com.stc.eWays.psofthandler.jar file is installed. You may need to use the system’s 
full host name.
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Using the PeopleSoft eWay with eInsight

This chapter describes how to use the PeopleSoft eWay with the Sun Java Composite 
Application Platform Suite’s eInsight Business Process Manager and the Web Services 
interface.

Note: You must have the eInsight.sar file installed to use the Web Services interface.

What’s in This Chapter

The eInsight Engine and Components on page 62

The PeopleSoft eWay With eInsight on page 63

The PeopleSoft eWay eInsight Sample Project on page 63

Importing a Sample Project on page 64

Creating the prjPeopleSoft_Sample_BPEL Project on page 65

Creating an Environment on page 75

Running the Sample on page 80

5.1 The eInsight Engine and Components
eGate components can be deployed as Activities in eInsight Business Processes. Using 
the Enterprise Designer with eInsight, you can add an Activity to a Business Process, 
then associate that Activity with an eGate component, such as an eWay. Then, when 
eInsight runs the Business Process, it automatically invokes that component using its 
Web Services interface. eGate components that can interface with eInsight in this way 
include:

Object Type Definitions (OTDs)

eWays

Collaborations

See the eInsight Business Process Manager User’s Guide for details.
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5.2 The PeopleSoft eWay With eInsight
An eInsight Business Process Activity can be associated with the PeopleSoft eWay 
during the system design phase. To make this association, select the desired operators 
under the eWay in the Enterprise Explorer and drag it onto the eInsight Business 
Process Designer canvas. 

The PeopleSoft eWay has the following operators available:

sendMessage (for PSoftHTTP client)

processRequest (for PSoftHTTPServer) This supplies both the receive and reply 
operators.

The operation is automatically changed to an Activity with an icon identifying the 
component that is the basis for the Activity. At run time, eInsight invokes each step in 
the order defined by the Business Process. Using eInsight’s Web Services interface, the 
Activity in turn invokes the PeopleSoft eWay. 

5.3 The PeopleSoft eWay eInsight Sample Project
The PeopleSoft eWay sample eInsight Project, prjPeopleSoft_Sample_BPEL, includes 
the following sample operations:

HTTPtoPS: publishes messages to PeopleSoft using HTTP (see Figure 31). 

PStoHTTP: Receives messages from PeopleSoft using HTTP (see Figure 32 on 
page 64). 

This PeopleSoft sample Project is for PeopleTools 8.42, and demonstrates how 
eInsight/eGate communicates with PeopleSoft using HTTP. 

The eInsight HTTP sample Project contains an outbound and an inbound data flow. The 
outbound data flow is from eGate to PeopleSoft; the inbound flow is from PeopleSoft to 
eGate. Figure 31 shows the outbound data flow in the Connectivity Map.
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Figure 31   eInsight HTTP Sample Project—Outbound Data Flow

In this data flow, the inbound File eWay receives the sample PSHTTP_BPEL data file 
from the input directory. The Business Process bpHTTPtoPS receives the input data, 
and publishes the data to the external PeopleSoft server using HTTP. The response from 
the PeopleSoft server is written to an external file using the outbound File eWay.

Figure 32   eInsight HTTP Sample Project—Inbound Data Flow

In the inbound data flow, displayed in Figure 32, the Business Process, bpPStoHTTP, 
receives a message from the PeopleSoft server using HTTP and publishes the contents 
of the message to an external file using the outbound File eWay.

The following pages provide directions for importing and completing the sample 
Project. In addition, this chapter provides directions for creating the sample Project 
manually. 

For more information on using eInsight and creating Business Processes, see the Sun 
SeeBeyond eInsight™ Business Process Manager User’s Guide. 

5.4 Importing a Sample Project
Sample eWay Projects are included as part of the installation package. To import a 
sample eWay Project to the Enterprise Designer do the following:

1 The sample files are uploaded with the eWay’s documentation SAR file and 
downloaded from the Sun Composite Application Platform Suite Installer’s 
Documentation tab. The PeopleSoft_eWay_Sample.zip file contains the various 
sample Project zip files and sample data. Extract the samples to a local file.
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2 Save all unsaved work before importing a Project.

3 From the Enterprise Designer’s Project Explorer pane, right-click the Repository 
and select Import from the shortcut menu. The Import Manager appears.

4 Browse to the directory that contains the sample Project zip file. Select the sample 
file (for this sample, prjPeopleSoft_Sample_BPEL.zip) and click Import. After the 
sample Project is successfully imported you can import additional samples or click 
Close to exit the Import Manager. 

5 Before an imported sample Project can be run you must do the following:

Create an Environment (see “Creating an Environment” on page 75)

Configure the eWays for your specific system (see “Configuring the eWays” on 
page 76)

Create a Deployment Profile (see “Creating and Activating the Deployment 
Profile” on page 78)

Create and start a domain (see “Creating and Starting the Domain” on 
page 79)

Build and deploy the Project (see “Building and Deploying the Project” on 
page 79)

The following pages provide step by step directions for manually creating the 
prjPeopleSoft_Sample_BPEL Project. 

5.5 Creating the prjPeopleSoft_Sample_BPEL Project
The prjPeopleSoft_Sample_BPEL Project demonstrates the same operations as the 
prjPeopleSoft_Sample_JCD Project. The difference between the two Projects is that the 
prjPeopleSoft_Sample_BPEL Project uses eInsight Business Processes to perform the 
business logic, where as the prjPeopleSoft_Sample_JCD uses Java Collaborations to 
perform the business logic. 

The following pages provide step by step directions for creating the 
prjPeopleSoft_Sample_BPEL Project.

5.5.1 Creating a Project
The first step is to create a new Project in the Enterprise Designer.

1 Start the Enterprise Designer.

2 From the Project Explorer tree, right-click the Repository and select New Project 
(see Figure 33). A new Project (Project1) appears on the Project Explorer tree.
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Figure 33   Enterprise Explorer - New Project

3 Rename the Project (for this sample, prjPeopleSoft_Sample_BPEL).

5.5.2 Creating The Business Processes
The next step is to create the Project’s two Business Processes:

bpHTTPtoPS

bpPStoHTTP

To create the Business Processes, do the following:

Create the bpHTTPtoPS Business Process

1 Right-click the prjPeopleSoft_Sample_BPEL Project in the Enterprise Designer’s 
Project Explorer, and select New > Business Process from the shortcut menu. The 
eInsight Business Process Designer appears and BusinessProcess1 is added to the 
Project Explorer tree. Rename BusinessProcess1 to bpHTTPtoPS.

2 From the Project Explorer tree, expand the Sun SeeBeyond > eWays > PSoftHTTP 
> PSoftHTTP and PSoftHTTPServer nodes, and also the File > FileClient nodes, 
to display all of the necessary activities for the Business Process.

3 Populate the eInsight Business Process Designer’s modeling canvas with the 
following activities from the Project Explorer tree as displayed in Figure 34:

receive, located under Sun SeeBeyond > eWays > File > FileClient

sendMessage, located under Sun SeeBeyond > eWays > PSoftHTTP > 
PSoftHTTP

write, located under Sun SeeBeyond > eWays > File > FileClient 
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Figure 34   eInsight Business Process Designer - Populate the Canvas

4 Link the modeling elements by clicking on the element connector and dragging the 
cursor to the next element connector, making the following links as displayed in 
Figure 35 on page 67.

Start to FileClient.receive

FileClient.receive to PSoftHTTP.sendMessage

PSoftHTTP.sendMessage to FileClient.write.

FileClient.write to End

Figure 35   Business Process Designer - Link the Modeling Elements

Configure the bpHTTPtoPS Modeling Elements 

Business Rules, created between the Business Process Activities, allow you to configure 
the relationships between the input and output Attributes of the Activities using the 
Business Process Designer’s Business Rule Designer. 

Adding Business Rules

1 Right-click the link between the FileClient.receive and PSoftHTTP.sendMessage 
Activities and select Add Business Rule from the shortcut menu (see Figure 36). 
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Figure 36   eInsight Business Process Designer - Adding Business Rules

Using the Business Rule Designer

2 From the eInsight Business Process Designer toolbar, click the Display Business 
Rule Designer button. The Business Rule Designer appears at the bottom of the 
eInsight Business Process Designer.

3 Click on the Business Rule icon in the link between FileClient.receive and 
PSoftHTTP.sendMessage to display the Business Rule’s Input and Output 
Attributes in the Business Rule Designer. 

4 Map text, under FileClient.receive.Output in the Output pane of the Business Rule 
Designer, to XMLMessage under PSoftHTTP.sendMessage.Input > 
PSoftHttpAppMsgRequestV842 in the Input pane of the Business Rule Designer. 
To do this, click on text in the Output pane and drag the cursor to XMLMessage in 
the Input pane. A link now connects the two nodes in the Business Rule Designer 
(see Figure 37 on page 68). 

Figure 37   Business Rule Designer - bpHTTPtoPS Business Process

5 Add another Business Rule in the link between PSoftHTTP.sendMessage and 
FileClient.write. Click on the new Business Rule icon between 
PSoftHTTP.sendMessage and FileClient.write to display the Business Rule’s Input 
and Output Attributes.

6 From the Business Rule Designer toolbar’s String menu, select concat. The concat 
method box appears.
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7 Double-click the String field of the concat method box and enter IB Response: as 
the value.

8 Map IBResponseXML, under PSoftHTTP.sendMessage.Output > 
PSoftHttpAppMsgResponseV842 in the Output pane of the Business Rule 
Designer, to the str (string) input node of the concat method box.

9 Map the return string output node of the concat method box, to text, under 
FileClient.write.Input in the Input pane of the Business Rule Designer (see Figure 
38). 

Figure 38   Business Rule Designer - bpHTTPtoPS Business Process

10 From the Business Process Designer toolbar, click the Synchronize Graphical 
Model and Business Process icon to synchronize the graphical interface to the 
Business Process code.

11 Save your changes to the Repository.

Create the bpPStoHTTP Business Process

1 Right-click the Project in the Enterprise Designer’s Project Explorer, and select New 
> Business Process from the shortcut menu. The eInsight Business Process Designer 
appears and BusinessProcess1 is added to the Project Explorer tree. Rename 
BusinessProcess1 to bpPStoHTTP.

2 Populate the eInsight Business Process Designer’s modeling canvas with the 
following activities from the Project Explorer tree as displayed in Figure 39:

processRequest, under Sun SeeBeyond > eWays > PSoftHTTP > 
PSoftHTTPServer (This automatically adds the processRequest.receive and 
the processRequest.Reply Activities to the Business Process Designer canvas.

write, under Sun SeeBeyond > eWays > File > FileClient

3 Link the modeling elements as displayed in Figure 39.
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Figure 39   Business Process Designer - bpPStoHTTP

Configure the bpPStoHTTP Modeling Elements 

To create the bpPStoHTTP Business Rules do the following: 

1 Right-click the link between the PSoftTHTTPServer.processRequest.Receive and 
PSoftTHTTPServer.processRequest.Reply Activities and select Add Business 
Rule from the shortcut menu.

2 From the eInsight Business Process Designer toolbar, click the Display Business 
Rule Designer button. The Business Rule Designer appears at the bottom of the 
eInsight Business Process Designer.

3 Click on the Business Rule icon in the link between 
PSoftTHTTPServer.processRequest.Receive and 
PSoftTHTTPServer.processRequest.Reply to display the Business Rule’s Input 
and Output Attributes in the Business Rule Designer. 

4 Map requestURL, under PSoftHTTPServer.processRequest.Output > 
webRequest in the Output pane of the Business Rule Designer, to text under 
PSoftHTTPServer.processRequest.Input in the Input pane of the Business Rule 
Designer (see Figure 40 on page 71). 
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Figure 40   Business Rule Designer - bpPStoHTTP Business Process

5 Add another Business Rule in the link between 
PSoftTHTTPServer.processRequest.Reply and FileClient.write. Click on the new 
Business Rule icon to display the Business Rule’s Input and Output Attributes.

6 Map text, under PSoftHTTPServer.processRequest.Output > webRequest in the 
Output pane of the Business Rule Designer, to text under FileClient.write.Input in 
the Input pane of the Business Rule Designer

7 From the Business Process Designer toolbar, click the Synchronize Graphical 
Model and Business Process icon to synchronize the graphical interface to the 
Business Process code.

8 Save your changes to the Repository.

5.5.3 Creating a Connectivity Map
The Connectivity Map provides a canvas for assembling and configuring a Project’s 
components. The prjPeopleSoft_Sample_BPEL Project uses two Connectivity Maps:

cmHTTPtoPS (outbound data flow)

cmPStoHTTP (inbound data flow)

To create the Connectivity Maps, do the following:

1 From the Project Explorer tree, right-click the new prjPeopleSoft_Sample_BPEL 
Project and select New > Connectivity Map from the shortcut menu. 
PeopleSoft eWay User’s Guide 71 Sun Microsystems, Inc.



Chapter 5 Section 5.5
Using the PeopleSoft eWay with eInsight Creating the prjPeopleSoft_Sample_BPEL Project
2 The New Connectivity Map appears and a node for the Connectivity Map is added 
under the Project on the Project Explorer tree labeled CMap1. Rename the 
Connectivity Map cmHTTPtoPS.

3 Create an additional Connectivity Map named cmPStoHTTP. 

Selecting the External Applications

The icons in the toolbar represent the available components used to populate the 
Connectivity Map canvas. In the Connectivity Maps, eWays are associated with 
External Systems. For example, to establish a connection to an external PeopleSoft 
HTTP Server application, you must first select PeopleSoft HTTP Server as an External 
Application to use in your Connectivity Map (see Figure 41). 

Figure 41   Connectivity Map - External Applications

1 Click the External Application icon on the Connectivity Map toolbar,

2 Select the External Applications you require to create your Project (for this sample, 
File, PeopleSoft HTTP Client, and PeopleSoft HTTP Server). Icons representing 
the selected External Applications are added to the Connectivity Map toolbar.

Populating the Connectivity Maps

For the cmHTTPtoPS Connectivity Map, add the Project components by dragging the 
icons from the toolbar to the canvas. 

1 For this sample, populate the Connectivity Map by dragging the following 
components onto the Connectivity Map canvas as displayed in Figure 42 on 
page 73.

File External System (2)

Service (A service is a container for Java Collaborations, Business Processes, eTL 
processes, and so forth)

PeopleSoft HTTP Client

2 Rename the cmHTTPtoPS Connectivity Map components as follows:

File1 to FileClientIN

cmHTTPtoPS_Service1 to cmHTTPtoPS_bpHTTPtoPS1

PSoftHTTPClient1 to eaPSoftHTTPClient

File2 to FileClientOut (see Figure 42 on page 73)
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Figure 42   Connectivity Map - cmHTTPtoPS

3 Populate the cmPStoHTTP Connectivity Map with the following components, as 
displayed in Figure 43 on page 73:

File External System (rename to eaPSoftHTTPServer)

Service (rename to cmPStoHTTP_bpPStoHTTP1)

File External System (rename to FileClientOUT)

Figure 43   cmPStoHTTP Connectivity Map

4 Save your current changes to the Repository.

5.5.4 Binding the eWay Components
After the Business Process have been created, the components are associated and 
bindings are created in the Connectivity Maps.

1 From the Project Explorer, double-click cmHTTPtoPS to display the cmHTTPtoPS 
Connectivity Map. 

2 Drag and drop the bpHTTPtoPS Business Process from the Project Explorer to the 
cmHTTPtoPS_bpHTTPtoPS1 Service. If the Business Process was successfully 
associated, the Service icon changes to a Business Process (see Figure 44 on 
page 74).
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Figure 44   Connectivity Map - Binding the Components

3 From the Connectivity Map canvas, double-click cmHTTPtoPS_bpHTTPtoPS1. 
The cmHTTPtoPS_bpHTTPtoPS1 binding dialog box appears using the 
bpHTTPtoPS Rule.

4 From the cmHTTPtoPS_bpHTTPtoPS1 binding dialog box, map FileSender 
(under Implemented Services) to the output node of the inbound FileClientIN 
External Application. To do this, click on FileSender under Implemented Services 
in the cmHTTPtoPS_bpHTTPtoPS1 binding box, and drag your cursor to the output 
node of the FileClientIN External Application. A link now joins the two 
components.

5 From the cmHTTPtoPS_bpHTTPtoPS1 binding dialog box, map 
PSoftHTTPReceiver (under Invoked Services) to the input node of the 
eaPSoftHTTPClient External Application.

6 From the cmHTTPtoPS_bpHTTPtoPS1 binding dialog box, map FileReceiver 
(under Invoked Services) to the input node of the FileClient External Application 
(see Figure 45 on page 74).

Figure 45   Connectivity Map - Associating (Binding) the Project’s Components

7 Minimize the cmHTTPtoPS_bpHTTPtoPS1 binding dialog box.

8 From the Project Explorer, double-click cmPStoHTTP to display the cmPStoHTTP 
Connectivity Map.
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9 Drag and drop the bpPStoHTTP Business Process from the Project Explorer to the 
cmPStoHTTP_bpPStoHTTP1 Service.

10 From the Connectivity Map, double-click the cmPStoHTTP_bpPStoHTTP1 
Service. The cmPStoHTTP_bpPStoHTTP1 binding dialog box appears with the 
bpPStoHTTP Rule.

11 From the cmPStoHTTP_bpPStoHTTP1 binding dialog box, map 
PSoftHTTPSender (under Implemented Services) to the output node of the 
eaPSoftHTTPServer External Application.

12 From the cmPStoHTTP_bpPStoHTTP1 binding dialog box, map FileReceiver 
(under Invoked Services) to the input node of the FileClientOUT External 
Application. 

13 Minimize the cmPStoHTTP_bpPStoHTTP1 binding dialog box. Save your current 
changes to the Repository.

5.5.5 Creating an Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a Project and contain the configuration information for these 
components. Environments are created using the Enterprise Designer’s Environment 
Editor.

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to envPeopleSoft_Sample_BPEL.

4 Right-click envPeopleSoft_Sample_BPEL and select New > File External System. 
Name the External System esFile and click OK. esFile is added to the Environment 
Editor.

5 Right-click envPeopleSoft_Sample_BPEL and select New > PSoftHTTP Client 
External System. Name the External System esPsoftHTTP_Client and click OK. 
esEmail is added to the Environment Editor. 

6 Right-click envPeopleSoft_Sample_BPEL and select New > PSoftHTTP Server 
External System. Name the External System esPsoftHTTP_Client and click OK. 
esEmail is added to the Environment Editor. 

7 Right-click envPeopleSoft_Sample_BPEL and select New > Logical Host. 
LogicalHost1 is added to the Environment Editor.

8 From the Environment Explorer tree, right-click LogicalHost1 and select New > 
Sun SeeBeyond Integration Server. A new Integration Server (IntegrationSvr1) is 
added to the Environment Explorer tree under LogicalHost1.

9 Save changes to the repository. The Environment Explorer and Environment Editor 
now appear as displayed in Figure 46.
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Figure 46   Environment Editor - envPeopleSoft_Sample_BPEL

10 Save your current changes to the Repository.

5.5.6 Configuring the eWays
The prjPeopleSoft_Sample_BPEL Project uses three eWays, each represented in the 
Connectivity Maps as a node between an External Application and a Service. eWays 
facilitate communication and movement of data between the External Applications and 
the eGate system. 

Figure 47   eWays

The eWay properties are set from both the Project Explorer’s Connectivity Maps and 
the Environment Explorer tree.

Configuring the File eWay Properties 

1 From the cmHTTPtoPS Connectivity Map, double-click the inbound FileClientIN 
eWay (see Figure 47). The Properties Editor opens to the inbound File eWay 
properties. 

2 Modify the properties for your system, including the settings for the inbound File 
eWay in Table 18, and click OK.

Table 18   cmHTTPtoPS - Inbound File eWay Settings

FileClientIN eWay Connection Parameters

Input file name PSHTTP_BPEL.in

Outbound File eWay

PeopleSoft HTTP Client eWay

Inbound File eWay
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3 From the cmHTTPtoPS Connectivity Map, modify the outbound FileClientOUT 
eWay properties for your system, including the settings in Table 19.

Table 19   cmHTTPtoPS - Outbound File eWay Settings

4 In the same way, modify the properties of the cmPStoHTTP Connectivity Maps 
outbound FileClientOUT eWay with the settings in Table 20.

Table 20   cmPStoHTTP - Outbound File eWay Settings

5 From the Environment Explorer tree, right-click the File eWay External System 
(esFile in this sample), and select Properties from the shortcut menu. The 
Properties Editor appears.

6 Modify the File eWay Environment properties for your system, including the 
settings in Table 21, and click OK.

Table 21   File eWay Environment Properties

Configuring the PeopleSoft eWay Properties

1 The default PeopleSoft eWay Connectivity Map properties are sufficient for this 
sample.

2 From the Environment Explorer tree, right-click the PeopleSoft HTTP Client eWay 
External System (esPSoftHTTP_Client in this sample), and select Properties from 
the shortcut menu. The Properties Editor appears.

3 Modify the PeopleSoft HTTP Client eWay Environment properties for your system, 
including the following settings:

Destination node

Message name

Message version

Requesting node

These properties must match the configuration on your PeopleSoft server. For 
information refer to “Configuring PeopleTools 8.42” on page 37.

Outbound File eWay Connection Parameters

Output file name HTTPtoPS_BPEL_output.txt

Outbound File eWay Connection Parameters

Output file name PStoHTTP_BPEL_output.txt

File eWay Environment Properties 

Inbound File eWay > Parameter Settings Set as directed, otherwise use the default settings

Directory Select a directory, for example C:/DATA/input/Psoft

Outbound File eWay > Parameter Settings Set as directed, otherwise use the default settings

Directory Select a directory, for example C:/DATA/output
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5.5.7 Configuring the Integration Server
You must set your Sun SeeBeyond Integration Server Password property before 
deploying your Project. 

1 From the Environment Explorer, right-click IntegrationSvr1 under your Logical 
Host, and select Properties from the shortcut menu. The Integration Server 
Properties Editor appears.

2 Click the Password property field under Sun SeeBeyond Integration Server 
Configuration. An ellipsis appears in the property field.

3 Click the ellipsis. The Password Settings dialog box appears. Enter STC as the 
Specific Value and as the Confirm Password, and click OK.

4 Click OK to accept the new property and close the Properties Editor.

For more information on deploying a Project see the Sun SeeBeyond Java™ Composite 
Application Platform Suite Deployment Guide.

5.5.8 Creating and Activating the Deployment Profile
Deployment Profiles are used to assign Collaborations and message destinations to the 
integration server and message server. Deployment profiles are created using the 
Deployment Editor.

1 From the Project Explorer, right-click the prjPeopleSoft_Sample_BPEL Project and 
select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample 
dpPeopleSoft_Sample_BPEL). Select envPeopleSoft_Sample_BPEL as the 
Environment and click OK.

3 From the Deployment Editor toolbar, click the Automap icon (see Figure 48). 

Figure 48   dpPeopleSoft_Sample_BPEL Deployment Profile 

4 The Project’s components are automatically mapped to their system windows (see 
Figure 48 on page 78). 
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Figure 49   dpPeopleSoft_Sample_BPEL Deployment Profile 

5 Save your current changes to the Repository.

5.5.9 Creating and Starting the Domain
To deploy your Project you must first create a domain. After the domain is created, the 
Project is built and then deployed.

Create and Start the Domain

1 Navigate to your <JavaCAPS51>\logicalhost directory (where <JavaCAPS51> is 
the location of your Java Integration Suite installation.

2 Double-click the domainmgr.bat file. The Domain Manager appears.

3 If you have already created a domain, select your domain in the Domain Manager 
and click the Start an Existing Domain button. Once your domain is started, a 
green check mark indicates that the domain is running.

4 If there are no existing domains, a dialog box indicates that you can create a domain 
now. Click Yes. The Create Domain dialog box appears.

5 Make any necessary changes to the Create Domain dialog box and click Create. The 
new domain is added to the Domain Manager. Select the domain and click the Start 
an Existing Domain button. Once your domain is started, a green check mark 
indicates that the domain is running.

5.5.10 Building and Deploying the Project
The Build process compiles and validates the Project’s Java files and creates the Project 
EAR file.

Build the Project

1 From the Deployment Editor toolbar, click the Build icon for each of your 
Deployment Profiles.
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2 If there are any validation errors, a Validation Errors pane will appear at the bottom 
of the Deployment Editor and displays information regarding the errors. Make any 
necessary corrections and click Build again.

3 After the Build has succeeded you are ready to deploy your Project.

Deploy the Project

1 From the Deployment Editor toolbar, click the Deploy icon. Click Yes when the 
Deploy prompt appears. Do this for both of your Deployment Profiles.

2 A message appears when the project is successfully deployed. You can now test 
your sample.

Note: Projects can also be deployed from the Enterprise Manager. For more information 
about using the Enterprise Manager to deploy, monitor, and manage your projects, 
see the Sun SeeBeyond eGate™ Integrator System Administration Guide.

5.5.11 Running the Sample
The prjPeopleSoft_Sample_BPEL Project includes the following sample files:

PSHTTP_BPEL.in.~in (input file)

HTTPtoPS_BPEL_output.txt (sample output file example)

PStoHTTP_BPEL_output.txt (sample output file example)

To run your deployed sample Project do the following:

1 From your configured input directory, paste (or rename) the sample input file to 
trigger the eWay.

2 From your output directory, verify the output data. 
PeopleSoft eWay User’s Guide 80 Sun Microsystems, Inc.



Chapter 6

Using the PeopleSoft eWay with Java 
Collaborations

This chapter provides an introduction to the PeopleSoft eWay components and 
information on how these components are created and implemented in an eGate Project 
that uses Java Collaboration Definitions to provide the business logic. Java 
Collaboration Definition (JCD) sample Project performs the same operations as the 
eInsight Project.

For more information on creating an eGate Project see the Sun SeeBeyond eGate™ 
Tutorial and the Sun SeeBeyond eGate™ Integrator User’s Guide.

What’s in This Chapter

PeopleSoft eWay Components on page 81

Importing a Sample Project on page 82

The PeopleSoft eWay JCD Sample Project on page 82

Creating the prjPeopleSoft_Sample_JCD Project on page 84

Creating an Environment on page 95

Running the Sample on page 100

6.1 PeopleSoft eWay Components
This chapter presents a sample PeopleSoft eWay Project created using the same 
procedures as the sample end-to-end Project provided in the Sun SeeBeyond eGate 
Tutorial. Components that are unique to the PeopleSoft eWay include the following:

PeopleSoft eWay Properties File

The properties file for the PeopleSoft eWay contains the parameters that are used to 
connect with a specific external system. These parameters are set using the Properties 
Editor. For more information about the PeopleSoft eWay properties file and the 
Properties Editor see “Configuring the e-Mail eWay Properties” on page 18.

PeopleSoft OTDs

The PeopleSoft eWay includes the PSoftHTTP and PSoftHTTPServer OTDs contain the 
data structures and rules that define a PeopleSoft object. These OTDs are used in the 
Collaboration Definitions to create transform data and interface with external systems. 
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6.2 Importing a Sample Project
Sample eWay Projects are included as part of the installation package. To import a 
sample eWay Project to the Enterprise Designer do the following:

1 The sample files are uploaded with the eWay’s documentation SAR file and 
downloaded from the Sun Composite Application Platform Suite Installer’s 
Documentation tab. The PeopleSoft_eWay_Sample.zip file contains the various 
sample Project zip files and sample data. Extract the samples to a local file.

2 Save all unsaved work before importing a Project.

3 From the Enterprise Designer’s Project Explorer pane, right-click the Repository 
and select Import from the shortcut menu. The Import Manager appears.

4 Browse to the directory that contains the sample Project zip file. Select the sample 
file (for this sample, prjPeopleSoft_Sample_JCD.zip) and click Import. After the 
sample Project is successfully imported you can import additional samples or click 
Close to exit the Import Manager. 

5 Before an imported sample Project can be run you must do the following:

Create an Environment (see “Creating an Environment” on page 95)

Configure the eWays for your specific system (see “Configuring the eWays” on 
page 96)

Create a Deployment Profile (see “Creating and Activating the Deployment 
Profile” on page 99)

Create and start a domain (see “Creating and Starting the Domain” on 
page 100)

Build and deploy the Project (see “Building and Deploying the Project” on 
page 100)

The following pages provide step by step directions for manually creating the 
prjPeopleSoft_Sample_JCD Project. 

6.3 The PeopleSoft eWay JCD Sample Project
The PeopleSoft eWay sample Java Collaboration Definition (JCD) Project, 
prjPeopleSoft_Sample_JCD, includes the following sample operations:

HTTPtoPS: publishes messages to PeopleSoft using HTTP (see Figure 50 on 
page 83). 

PStoHTTP: Receives messages from PeopleSoft using HTTP (see Figure 51 on 
page 83). 

This PeopleSoft sample Project is for PeopleTools 8.42, and demonstrates how eGate 
communicates with PeopleSoft using HTTP. 
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The eInsight HTTP sample Project contains an outbound and an inbound data flow. The 
outbound data flow is from eGate to PeopleSoft; the inbound flow is from PeopleSoft to 
eGate. Figure 50 shows the outbound data flow in the Connectivity Map.

Figure 50   JCD HTTP Sample Project—Outbound Data Flow

In this data flow, the inbound File eWay receives the sample PSHTTP_BPEL data file 
from the input directory. The Collaboration, cmHTTPtoPS_jcdHTTPtoPS1, receives 
the input data, and publishes the data to the external PeopleSoft server using HTTP, 
and receives a response from the server. The response is written to an external file using 
the outbound File eWay

Figure 51   JCD HTTP Sample Project—Inbound Data Flow

In the inbound data flow, displayed in Figure 51, the Collaboration, 
cmPStoHTTP_jcdPStoHTTP2, receives a message from the PeopleSoft server using 
HTTP, and publishes the contents of the message to an external file using the outbound 
File eWay.

The following pages provide directions for importing and completing this sample 
Project. In addition, this chapter provides directions for creating the sample Project 
manually. 

For more information on creating Java Collaborations, see the Sun SeeBeyond eGate™ 
Integrator User’s Guide.
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6.4 Creating the prjPeopleSoft_Sample_JCD Project
The prjPeopleSoft_Sample_JCD Project demonstrates the same operations as the 
prjPeopleSoft_Sample_JCD Project. The difference between the two Projects is that the 
prjPeopleSoft_Sample_BPEL Project uses eInsight Business Processes to perform the 
business logic, where as the prjPeopleSoft_Sample_JCD uses Java Collaborations to 
perform the business logic. 

The following pages provide step by step directions for creating the 
prjPeopleSoft_Sample_JCD Project.

6.4.1 Creating a Project
The first step is to create a new Project in the Enterprise Designer.

1 Start the Enterprise Designer.

2 From the Project Explorer tree, right-click the Repository and select New Project 
(see Figure 52). A new Project (Project1) appears on the Project Explorer tree.

Figure 52   Enterprise Explorer - New Project

3 Rename the Project (for this sample, prjPeopleSoft_Sample_JCD).

6.4.2 Creating the Collaboration Definitions
The next step in the sample is to create two Java Collaborations using the Collaboration 
Definition Wizard (Java). Once the Collaboration Definitions have been created, the 
Business Rules of the Collaborations can be written using the Collaboration Editor 
(Java).
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Create the jcdHTTPtoPS Collaboration Definition 

The jcdHTTPtoPS Collaboration defines transactions between the inbound File eWay, 
the PeopleSoft HTTP Client eWay, and the outbound File eWay.

1 From the Project Explorer, right-click the sample Project and select New > 
Collaboration Editor (Java) from the shortcut menu. The Collaboration Definition 
Wizard (Java) appears.

2 Enter a Collaboration Definition name (for this sample jcdHTTPtoPS) and click 
Next.

3 For Step 2 or the wizard, from the Web Services Interfaces selection window, 
double-click Sun SeeBeyond > eWays > File > FileClient > receive. The File Name 
field now displays receive. Click Next.

4 For Step 3 of the wizard, from the Select OTDs to be used in this Collaboration 
window, double-click Sun SeeBeyond > eWays > File > FileClient. The 
FileClient_1 OTD is added to the Selected OTDs field.

5 Click the Up One Level button to return your Repository. From the Select OTDs to 
be used in this Collaboration window, double-click Sun SeeBeyond > eWays > 
PSoftHTTP > PSoftHTTP. The PSoftHTTP_1 OTD is added to the Selected OTDs 
field (see Figure 53).

Figure 53   Collaboration Definition Wizard (Java) 

6 Click Finish. The Collaboration Editor (Java) with the new jcdHTTPtoPS 
Collaboration appears in the right pane of the Enterprise Designer.
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Create the jcdPStoHTTP Java Collaboration

The jcdPStoHTTP Collaboration (Java) defines transactions between the inbound 
PeopleSoft HTTP Server eWay application to the Outbound File eWay. 

1 From the Project Explorer, right-click the sample Project and select New > 
Collaboration Editor (Java) from the shortcut menu. The Collaboration Definition 
Wizard (Java) appears.

2 Enter a Collaboration Definition name (for this sample jcdPStoHTTP) and click 
Next. 

3 For Step 2 of the wizard, from the Web Services Interfaces selection window, 
double-click Sun SeeBeyond > eWays > PsoftHTTPServer > PsoftHTTPServer > 
processRequest. The Name field now displays processRequest. Click Next.

4 For Step 3, Select OTDs, from the Select OTDs selection window, double-click Sun 
SeeBeyond > eWays > File > FileClient. The FileClient_1 OTD is added to the 
Selected OTDs field. 

5 Click Finish. The Collaboration Editor with the new jcdPStoHTTP Collaboration 
appears.

6.4.3 Using the Collaboration Editor (Java)
The next step in the sample is to create the Business Rules of the Collaborations using 
the Collaboration Editor (Java). 

Creating the jcdHTTPtoPS Business Rules

The jcdHTTPtoPS Collaboration contains the Business Rule displayed in Figure 54.

Figure 54   jcdHTTPtoPS Collaboration Business Rules

Note: The code of the jcdHTTPtoPS Collaboration Business Rules is wrapped for display 
purposes only.
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To create the jcdHTTPtoPS Collaboration Business Rules do the following:

1 From the Project Explorer tree, double-click jcdHTTPtoPS to open the 
Collaboration Editor (Java) to the jcdHTTPtoPS Collaboration.

2  To create comments for the Business Rules, click the comment icon on the Business 
Rules toolbar. The Enter a Comment dialog box appears. Enter the comment and 
click OK. The comment is placed on the Business Rules tree under the last selected 
item. Once the Comment is created, it can be moved by clicking the comment and 
dragging it up or down the Business Rules tree to a new location.

3 Create the Copy null to variable outString Business Rule:

A From the Business Rules toolbar, click Local Variable. The Create Variable 
dialog box appears.

B Enter outString as the variable name.

C For Type, select Class and click the ellipsis (...) button. The Class Browser dialog 
box appears. 

D From the Class Browser dialog box, select String as the class and click OK.

E Click OK to close the Create Variable dialog box and create the variable.

F From the Business Rules Designer toolbar’s Object menu, select Null. The 
Object method box appears with null as the value.

G Map the null output node of the Object method box to outString (variable) in 
the right pane of the Business Rules Designer (see Figure 55).

Figure 55   Collaboration Editor (Java) - Business Rules Designer

4 Create the Copy input.Text to 
PSoftHTTP_1.PeopleSoftAppMessage.PSoftHttpAppMsgV842.PSoftHttpAppM
sgRequestV842.XMLMessage rule:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B Map Text under input in the left pane of the Business Rules Designer, to 
XMLMessage under PSoftHTTP_1 > PeopleSoftAppMessage > 
PSoftHttpAppMsgV842 > PSoftHttpAppMsgRequestV842 in the right pane of 
the Business Rules Designer. To do this, click on Text in the left pane of the 
Business Rules Designer, and drag your cursor to XMLMessage in the right 
pane of the Business Rules Designer. A link now connects the two nodes (see 
Figure 56). 
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Figure 56   jcdHTTPtoPS - Business Rules Designer

5 Create the PSoftHTTP_1.sendMessage rule:

A From the Business Rules toolbar, click the rule icon to add a new rule. 

B From the left pane of the Business Rules Designer, right-click PSoftHTTP_1 and 
click Select method to call, from the shortcut menu. 

C From the method selection window, select sendMessage(). The sendMessage 
method box appears (see Figure 57).

Figure 57   jcdHTTPtoPS - Business Rules Designer

6 Create the Copy 
PSoftHTTP_1.PeopleSoftAppMessage.PSoftHttpAppMsgV842.PSoftHttpAppM
sgResponseV842.IBResponseXML to outString rule:

A From the Business Rules toolbar, click the rule icon to add a new rule. 
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B Map IBResponseXML, under PSoftHTTP_1 > PeopleSoftAppMessage > 
PSoftHttpAppMsgV842 > PSoftHttpAppMsgResponseV842 in the left pane of 
the Business Rules Designer, to outString (variable), in the right pane of the 
Business Rules Designer. 

7 Create the If statement and the condition: outString is equal to null rule:

A From the Business Rules toolbar, click the If-then icon. an If statement is added 
to the Business Rules tree. Select the condition under the If statement.

B From the Business Rules Designer toolbar’s Comparison menu, select Equal. 
The Equal method box appears.

C Map outString (variable), in the left pane of the Business Rules Designer, to the 
value1 input node of the Equal method box. 

D Right-click the value2 field of the Equal method box and select Add null literal 
from the shortcut menu. The field now shows the value null.

E Map the result (boolean) output node of the Equal method box to condition in 
the right pane of the Business Rules Designer (see Figure 58).

Figure 58   jcdHTTPtoPS - Business Rules Designer

8 Create the Copy "=====> HTTP process completed." to FileClient_1.Text rule 
under the If-then statement:

A Select the then under the If statement, and from the Business Rules toolbar, click 
the rule icon to add a new rule. 

B From the Business Rules Designer toolbar’s String menu, select Literal String. 
The String literal box appears. Enter =====> HTTP process completed. as the 
String literal value.

C Map “=====> HTTP process completed.” output node of the String literal box, 
to Text under FileClient_1, in the right pane of the Business Rules Designer.

9 Create the FileClient_1.write rule under the If-then statement:

A From the Business Rules toolbar, click the rule icon to add a new rule under the 
If-then statement.

B From the left pane of the Business Rules Designer, right-click FileClient_1 and 
click Select method to call, from the shortcut menu. 
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C From the method selection window, select write(). The write method box 
appears.

10 Create the Copy "IB Response: 
".concat(PSoftHTTP_1.PeopleSoftAppMessage.PSoftHttpAppMsgV842.PSoftHtt
pAppMsgResponseV842.IBResponseXML) to FileClient_1.Text rule under the If-
then-else statement:

A Select the else under the If statement, and from the Business Rules toolbar, click 
the rule icon to add a new rule.

B From the Business Rules Designer toolbar’s String menu, select concat. The 
concat method box appears. 

C Right-click the String field of the concat method box and select Add Literal 
from the shortcut menu. Enter IB Response: as the String literal value.

D Map IBResponseXML, under PSoftHTTP_1 > PeopleSoftAppMessage > 
PSoftHttpAppMsgV842 > PSoftHttpAppMsgResponseV842 in the left pane of 
the Business Rules Designer, to the str (String) input node of the concat method 
box. 

E Map the result (String) output node of the concat method box, to Text under 
FileClient_1, in the right pane of the Business Rules Designer (see Figure 58).

Figure 59   jcdHTTPtoPS - Business Rules Designer

11 Create the FileClient_1.write rule under the If-then-else statement:

A From the Business Rules toolbar, click the rule icon to add a new rule under the 
If-then else statement.

B From the left pane of the Business Rules Designer, right-click FileClient_1 and 
click Select method to call, from the shortcut menu. 

C From the method selection window, select write(). The write method box 
appears.
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12 From the editor’s toolbar, click Validate to check the Collaboration for errors.

13 Save your current changes to the repository.

Creating the jcdPStoHTTP Collaboration Business Rules

The jcdPStoHTTP Collaboration contains the Business Rule displayed in Figure 60

Figure 60   jcdPStoHTTP Collaboration Business Rules

To create the jcdPStoHTTP Collaboration Business Rules do the following:

1 From the Project Explorer tree, double-click jcdPStoHTTP to open the 
Collaboration Editor (Java) to the jcdPStoHTTP Collaboration.

2 Create the Copy input.Request.RequestURL to input.Response.Text Business 
Rule:

D Map RequestURL under input > Request in the left pane of the Business Rules 
Designer, to Text under input > Response in the right pane of the Business Rules 
Designer.

3 Create the input.sendResponse rule:

A From the Business Rules toolbar click the rule icon to add a new rule.

B From the left pane of the Transformation Designer, right-click input and click 
Select a method to call from the shortcut menu. The method selection box 
appears.

C Select sendResponse(). The sendResponse method box appears.

4 Create the input.sendResponse rule:

A From the Business Rules toolbar click the rule icon to add a new rule.

B Map Text under input > Request in the left pane of the Business Rules Designer, 
to Text under FileClient_1 in the right pane of the Business Rules Designer.

5 Create the FileClient_1.write rule:

A From the Business Rules toolbar, click the rule icon to add a new rule.

B From the left pane of the Business Rules Designer, right-click FileClient_1 and 
click Select method to call, from the shortcut menu. 

C From the method selection window, select write(). The write method box 
appears.
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6 From the editor’s toolbar, click Validate to check the Collaboration for errors.

7 Save your current changes to the repository.

For more information on the Collaboration Rules Editor see the Sun SeeBeyond eGate™ 
Integrator User’s Guide.

6.4.4 Creating a Connectivity Map
The Connectivity Map provides a canvas for assembling and configuring a Project’s 
components. The prjPeopleSoft_Sample_JCD Project uses two Connectivity Maps:

cmHTTPtoPS (outbound data flow)

cmPStoHTTP (inbound data flow)

To create the Connectivity Maps, do the following:

1 From the Project Explorer tree, right-click the new prjPeopleSoft_Sample_JCD 
Project and select New > Connectivity Map from the shortcut menu. 

2 The New Connectivity Map appears and a node for the Connectivity Map is added 
under the Project on the Project Explorer tree labeled CMap1. Rename the 
Connectivity Map cmHTTPtoPS.

3 Create an additional Connectivity Map named cmPStoHTTP. 

Selecting the External Applications

The icons in the toolbar represent the available components used to populate the 
Connectivity Map canvas. In the Connectivity Maps, eWays are associated with 
External Systems. For example, to establish a connection to an external PeopleSoft 
HTTP Server application, you must first select PeopleSoft HTTP Server as an External 
Application to use in your Connectivity Map (see Figure 61). 

Figure 61   Connectivity Map - External Applications

1 Click the External Application icon on the Connectivity Map toolbar,

2 Select the External Applications you require to create your Project (for this sample, 
File, PeopleSoft HTTP Client, and PeopleSoft HTTP Server). Icons representing 
the selected External Applications are added to the Connectivity Map toolbar.
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Populating the Connectivity Maps

For the cmHTTPtoPS Connectivity Map, add the Project components by dragging the 
icons from the toolbar to the canvas. 

1 For this sample, populate the Connectivity Map by dragging the following 
components onto the Connectivity Map canvas as displayed in Figure 62.

File External System (2)

Service (A service is a container for Java Collaborations, Business Processes, eTL 
processes, and so forth)

PeopleSoft HTTP Client

2 Rename the cmHTTPtoPS Connectivity Map components as follows:

File1 to FileClientIN

cmHTTPtoPS_Service1 to cmHTTPtoPS_jcdHTTPtoPS1

PSoftHTTPClient1 to eaPSoftHTTPClient

File2 to FileClientOut (see Figure 62)

Figure 62   Connectivity Map - cmHTTPtoPS

3 Populate the cmPStoHTTP Connectivity Map with the following components, as 
displayed in Figure 63 on page 93:

File External System (rename to eaPSoftHTTPServer)

Service (rename to cmPStoHTTP_jcdPStoHTTP1)

File External System (rename to FileClientOUT)

Figure 63   cmPStoHTTP Connectivity Map

4 Save your current changes to the Repository.
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6.4.5 Binding the eWay Components
After the Collaborations have been created, the components are associated and 
bindings are created in the Connectivity Maps.

1 From the Project Explorer, double-click cmHTTPtoPS to display the cmHTTPtoPS 
Connectivity Map. 

2 Drag and drop the jcdHTTPtoPS Collaboration from the Project Explorer to the 
cmHTTPtoPS_jcdHTTPtoPS1 Service. If the Collaboration was successfully 
associated, the Service icon changes from red to green (see Figure 64).

Figure 64   Connectivity Map - Binding the Components

3 From the Connectivity Map canvas, double-click cmHTTPtoPS_jcdHTTPtoPS1. 
The cmHTTPtoPS_jcdHTTPtoPS1 binding dialog box appears using the 
jcdHTTPtoPS Rule.

4 From the cmHTTPtoPS_jcdHTTPtoPS1 binding dialog box, map FileSender 
(under Implemented Services) to the output node of the inbound FileClientIN 
External Application. To do this, click on FileSender under Implemented Services 
in the cmHTTPtoPS_jcdHTTPtoPS1 binding box, and drag your cursor to the 
output node of the FileClientIN External Application. A link now joins the two 
components.

5 From the cmHTTPtoPS_jcdHTTPtoPS1 binding dialog box, map 
PSoftHTTPReceiver (under Invoked Services) to the input node of the 
eaPSoftHTTPClient External Application.

6 From the cmHTTPtoPS_jcdHTTPtoPS1 binding dialog box, map FileReceiver 
(under Invoked Services) to the input node of the FileClient External Application 
(see Figure 65 on page 95).
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Figure 65   Connectivity Map - Associating (Binding) the Project’s Components

7 Minimize the cmHTTPtoPS_jcdHTTPtoPS1 binding dialog box.

8 From the Project Explorer, double-click cmPStoHTTP to display the cmPStoHTTP 
Connectivity Map.

9 Drag and drop the jcdPStoHTTP Collaboration from the Project Explorer to the 
cmPStoHTTP_jcdPStoHTTP1 Service.

10 From the Connectivity Map, double-click the cmPStoHTTP_jcdPStoHTTP1 
Service. The cmPStoHTTP_jcdPStoHTTP1 binding dialog box appears with the 
jcdPStoHTTP Rule.

11 From the cmPStoHTTP_jcdPStoHTTP1 binding dialog box, map 
PSoftHTTPSender (under Implemented Services) to the output node of the 
eaPSoftHTTPServer External Application.

12 From the cmPStoHTTP_jcdPStoHTTP1 binding dialog box, map FileReceiver 
(under Invoked Services) to the input node of the FileClientOUT External 
Application. 

13 Minimize the cmPStoHTTP_jcdPStoHTTP1 binding dialog box. Save your current 
changes to the Repository.

6.4.6 Creating an Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a Project and contain the configuration information for these 
components. Environments are created using the Enterprise Designer’s Environment 
Editor.

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to envPeopleSoft_Sample_JCD.
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4 Right-click envPeopleSoft_Sample_JCD and select New > File External System. 
Name the External System esFile and click OK. esFile is added to the Environment 
Editor.

5 Right-click envPeopleSoft_Sample_JCD and select New > PSoftHTTP Client 
External System. Name the External System esPsoftHTTP_Client and click OK. 
esEmail is added to the Environment Editor. 

6 Right-click envPeopleSoft_Sample_JCD and select New > PSoftHTTP Server 
External System. Name the External System esPsoftHTTP_Client and click OK. 
esEmail is added to the Environment Editor. 

7 Right-click envPeopleSoft_Sample_JCD and select New > Logical Host. 
LogicalHost1 is added to the Environment Editor.

8 From the Environment Explorer tree, right-click LogicalHost1 and select New > 
Sun SeeBeyond Integration Server. A new Integration Server (IntegrationSvr1) is 
added to the Environment Explorer tree under LogicalHost1.

9 Save changes to the repository. The Environment Explorer and Environment Editor 
now appear as displayed in Figure 66.

Figure 66   Environment Editor - envPeopleSoft_Sample_JCD

10 Save your current changes to the Repository.

6.4.7 Configuring the eWays
The prjPeopleSoft_Sample_JCD Project uses three eWays, each represented in the 
Connectivity Maps as a node between an External Application and a Service (see 
Figure 67 on page 97). eWays facilitate communication and movement of data between 
the External Applications and the eGate system. 
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Figure 67   eWays

The eWay properties are set from both the Project Explorer’s Connectivity Maps and 
the Environment Explorer tree.

Configuring the File eWay Properties 

1 From the cmHTTPtoPS Connectivity Map, double-click the inbound FileClientIN 
eWay (see Figure 67). The Properties Editor opens to the inbound File eWay 
properties. 

2 Modify the properties for your system, including the settings for the inbound File 
eWay in Table 22, and click OK.

Table 22   cmHTTPtoPS - Inbound File eWay Settings

3 From the cmHTTPtoPS Connectivity Map, modify the outbound FileClientOUT 
eWay properties for your system, including the settings in Table 23.

Table 23   cmHTTPtoPS - Outbound File eWay Settings

4 In the same way, modify the properties of the cmPStoHTTP Connectivity Maps 
outbound FileClientOUT eWay with the settings in Table 24.

Table 24   cmPStoHTTP - Outbound File eWay Settings

5 From the Environment Explorer tree, right-click the File eWay External System 
(esFile in this sample), and select Properties from the shortcut menu. The 
Properties Editor appears.

6 Modify the File eWay Environment properties for your system, including the 
settings in Table 25 on page 98, and click OK.

FileClientIN eWay Connection Parameters

Input file name PSHTTP_BPEL.in

Outbound File eWay Connection Parameters

Output file name HTTPtoPS_BPEL_output.txt

Outbound File eWay Connection Parameters

Output file name PStoHTTP_BPEL_output.txt

Outbound File eWay

PeopleSoft HTTP Client eWay

Inbound File eWay
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Table 25   File eWay Environment Properties

Configuring the PeopleSoft eWay Properties

1 The default PeopleSoft eWay Connectivity Map properties are sufficient for this 
sample.

2 From the Environment Explorer tree, right-click the PeopleSoft HTTP Client eWay 
External System (esPSoftHTTP_Client in this sample), and select Properties from 
the shortcut menu. The Properties Editor appears.

3 Modify the PeopleSoft HTTP Client eWay Environment properties for your system, 
including the following settings:

Destination node

Message name

Message version

Requesting node

These properties must match the configuration on your PeopleSoft server. For 
information refer to “Configuring PeopleTools 8.42” on page 37.

6.4.8 Configuring the Integration Server
You must set your Sun SeeBeyond Integration Server Password property before 
deploying your Project. 

1 From the Environment Explorer, right-click IntegrationSvr1 under your Logical 
Host, and select Properties from the shortcut menu. The Integration Server 
Properties Editor appears.

2 Click the Password property field under Sun SeeBeyond Integration Server 
Configuration. An ellipsis appears in the property field.

3 Click the ellipsis. The Password Settings dialog box appears. Enter STC as the 
Specific Value and as the Confirm Password, and click OK.

4 Click OK to accept the new property and close the Properties Editor.

For more information on deploying a Project see the Sun SeeBeyond Java™ Composite 
Application Platform Suite Deployment Guide.

File eWay Environment Properties 

Inbound File eWay > Parameter Settings Set as directed, otherwise use the default settings

Directory Select a directory, for example C:/DATA/input/Psoft

Outbound File eWay > Parameter Settings Set as directed, otherwise use the default settings

Directory Select a directory, for example C:/DATA/output
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6.4.9 Creating and Activating the Deployment Profile
Deployment Profiles are used to assign Collaborations and message destinations to the 
integration server and message server. Deployment profiles are created using the 
Deployment Editor.

1 From the Project Explorer, right-click the prjPeopleSoft_Sample_JCD Project and 
select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample 
dpPeopleSoft_Sample_JCD). Select envPeopleSoft_Sample_JCD as the 
Environment and click OK.

3 From the Deployment Editor toolbar, click the Automap icon (see Figure 68 on 
page 99). 

Figure 68   dpPeopleSoft_Sample_JCD Deployment Profile 

4 The Project’s components are automatically mapped to their system windows (see 
Figure 68). 

Figure 69   dpPeopleSoft_Sample_JCD Deployment Profile 

5 Save your current changes to the Repository.
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6.4.10 Creating and Starting the Domain
To deploy your Project you must first create a domain. After the domain is created, the 
Project is built and then deployed.

Create and Start the Domain

1 Navigate to your <JavaCAPS51>\logicalhost directory (where <JavaCAPS51> is 
the location of your Java Integration Suite installation.

2 Double-click the domainmgr.bat file. The Domain Manager appears.

3 If you have already created a domain, select your domain in the Domain Manager 
and click the Start an Existing Domain button. Once your domain is started, a 
green check mark indicates that the domain is running.

4 If there are no existing domains, a dialog box indicates that you can create a domain 
now. Click Yes. The Create Domain dialog box appears.

5 Make any necessary changes to the Create Domain dialog box and click Create. The 
new domain is added to the Domain Manager. Select the domain and click the Start 
an Existing Domain button. Once your domain is started, a green check mark 
indicates that the domain is running.

6.4.11 Building and Deploying the Project
The Build process compiles and validates the Project’s Java files and creates the Project 
EAR file.

Build the Project

1 From the Deployment Editor toolbar, click the Build icon for each of your 
Deployment Profiles.

2 If there are any validation errors, a Validation Errors pane will appear at the bottom 
of the Deployment Editor and displays information regarding the errors. Make any 
necessary corrections and click Build again.

3 After the Build has succeeded you are ready to deploy your Project.

Deploy the Project

1 From the Deployment Editor toolbar, click the Deploy icon. Click Yes when the 
Deploy prompt appears. Do this for both of your Deployment Profiles.

2 A message appears when the project is successfully deployed. You can now test 
your sample.

Note: Projects can also be deployed from the Enterprise Manager. For more information 
about using the Enterprise Manager to deploy, monitor, and manage your projects, 
see the Sun SeeBeyond eGate™ Integrator System Administration Guide.

6.4.12 Running the Sample
The prjPeopleSoft_Sample_JCD Project includes the following sample files:
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PSHTTP_JCD.in.~in (input file)

JCD_HTTPtoPS_output.txt (sample output file example)

JCD_PStoHTTP_output.txt (sample output file example)

To run your deployed sample Project do the following:

1 From your configured input directory, paste (or rename) the sample input file to 
trigger the eWay.

2 From your output directory, verify the output data. 
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Appendix A

Generating DTDs from PeopleSoft 8.13

This chapter describes how to generate DTDs from PeopleSoft 8.13, and use these DTDs 
to create the OTDs used to create the business logic for the PeopleSoft eWay. 

What’s in This Chapter

Generating DTDs from PeopleTools 8.13 on page 102

Creating OTDs on page 112

OTD Methods and Business Process Operations on page 112

A.1 Generating DTDs from PeopleTools 8.13
To create the OTD used with the eInsight PeopleSoft eWay Project, use the PeopleTools 
Application Designer 8.13 to generate the necessary Document Type Definitions 
(DTDs) using third-party software. You can then create an OTD that uses the generated 
DTD as described in “Creating OTDs” on page 112.

This section describes an alternative procedure that “reverse-engineers” a DTD from a 
sample XML message generated within PeopleSoft.

This procedure may not work for all message definitions. You must know the data 
constraints for a particular message definition to correctly populate the message with 
sample data.

Creating PeopleSoft DTDs involves the following steps:

1 Generating and Publishing an XML Test Message on page 102.

2 Extracting and Viewing the XML Test Message on page 106.

3 Generating a DTD for the XML File on page 110.

A.1.1   Generating and Publishing an XML Test Message
The first step to generate a DTD is to use the PeopleSoft 8 Application Designer to 
generate a PeopleSoft XML test message based on a particular message definition.

To generate a PeopleSoft XML message

1 Log into PeopleTools.

2 Log into the Application Designer.
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3 From the Application Designer’s File menu, click Open. The Open Object dialog 
box appears (see Figure 70).

Figure 70   Open Object Dialog Box - Object Type Message

4 Select Message as the object type, and click Open. A list of all available message 
definitions is displayed. 

5 Double-click the message definition for your message, for example, 
ADVANCED_SHIPPING_RECEIPT. The Message window displays the message 
structure (see Figure 71).

Figure 71   Message Structure Details

6 Right-click Version_1 in the message structure tree, and select Create Test Message 
from the shortcut menu. The Version_1 dialog box appears displaying the records 
contained in the ADVANCED_SHIPPING_RECEIPT message (see Figure 72 on 
page 104).
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Figure 72   Creating a Test Message

7 Expand the Transaction record to display all sub-records within the transaction 
record, as displayed in Figure 73.

Figure 73   Displaying Transaction Subrecords

Records can nest multiple levels as displayed in Figure 74.

Figure 74   Expanding Transaction Subrecords
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For the purpose of this example, only the fields ASN_RECEIVED_DT: 12/15/2000 
and ASN_STATUS: have data contained within them.

If there are no constraints requiring you to populate all fields in a record, then 
generate a well-formed XML message by populating only one field in each record 
and sub-record. For most message definitions, only one field is required to be 
populated with data (some contain default values).

If there are constraints, then all fields in each record and sub-record must be 
populated.

8 Enter data for the PSCAMA records as follows:

A Double-click a specific field. If the field displays empty, it is available for data 
input.

B Add the sample data (see Figure 75).

Figure 75   Version 1 - Create Test Message

9 Continue entering data until all other required records and sub-records are 
populated using the same method as above.

10 Once all records and sub-records of the message have been populated with data, 
click Apply to have the updates published to the PSFT_EP Message Node (see Figure 
76 on page 106). A message confirms that publication was successful.S
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Figure 76   Viewing the Test Message

11 Click OK to close the dialog box.

A.1.2   Extracting and Viewing the XML Test Message
The XML test message that you generated and published in the prior section can now 
be viewed using a supported Web browser. Refer to PeopleSoft PeopleBooks for more 
information about using the PeopleSoft 8 Application.

To view the XML message

1 Within a supported Web browser, log into the PeopleSoft 8 Application.

2 In PeopleSoft 8, click PeopleTools to open the PeopleTools application (see Figure 
77 on page 107).
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Figure 77   PeopleSoft 8 Application Contents Page

The PeopleTools Directory Tree appears as displayed in Figure 78.

Figure 78   PeopleTools Directory Tree
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3 Click Application Message Monitor > Use > Application Message Monitor, and 
click the hyperlink. The Application Message Monitor page opens to the Overview 
tab (see Figure 79).

Figure 79   Application Message Monitor - Overview Tab

4 From the Publish Node field, select the PSFT_EP message node.

5 Click Refresh. The number of messages published for the selected grouping, using 
the Create Test Message tool, is displayed.

6 Click the link indicated by the number of messages in the New, Done, or Working 
columns. The Message Instances tab appears, displaying a summary of the 
published messages (see Figure 80).

Figure 80   Application Message Monitor - Message Instances Tab
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7 Click the Details link to view the properties of the published XML message (see 
Figure 81).

Figure 81   Message Properties Tab

8 Click the XML Message Viewer tab to review the message itself.

9 Select the entire XML message (see Figure 82).

Figure 82   XML Message Viewer Tab

10 Copy and paste the XML message into a text editor and save it, with a .xml 
extension, to a temporary location. Use the same naming convention used for the 
name of the Message Definition. The example in Figure 83 on page 110 shows the 
saved XML Message ADVANCED_SHIPPING_RECEIPT.
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Figure 83   ADVANCED_SHIPPING_RECEIPT.xml

A.1.3   Generating a DTD for the XML File
The structure of the XML message must now be described in a DTD, from which an 
OTD is subsequently generated. PeopleSoft does not provide a DTD generation utility, 
but third-party utilities are available to accomplish this task.

A free, online DTD Generator utility is available at the following URL:

http://www.hitsw.com/

This utility is presented to illustrate the general procedures for generating a DTD. Sun 
Microsystems Inc. has no connection with, and does not support, this product.

1 From the XML Document to DTD field browse to and select the .xml file with the 
saved XML Message. For this example:

c:\temp\ADVANCED_SHIPPING_RECEIPT.xml

2 Click Open. The DTD Generator page reappears with the path and file displayed in 
the XML Document box (see Figure 84 on page 111).
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Figure 84   Example DTD Generator (2)

3 Click Generate DTD to generate the DTD. The DTD appears as displayed in Figure 
85.

Figure 85   Resulting DTD
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4 Select only the DTD-related information (usually all information except the first 
line).

5 Copy and paste the text into a text editor and save it with a .dtd extension to a 
temporary location. Use the same naming convention to name the message 
definition (for the example, ADVANCED_SHIPPING_RECEIPT).

Figure 86   DTD File

You can now use the DTD to create a PeopleSoft OTD using the Enterprise 
Designer’s DTD OTD wizard (see Creating OTDs on page 112).

A.2 Creating OTDs
To create OTDs for PeopleSoft Business Processes and Collaborations, you use the 
DTDs generated from PeopleSoft as described in “Generating DTDs from PeopleTools 
8.13” on page 102. You then create an OTD from the DTD using the Enterprise 
Designer’s DTD OTD Wizard. For information about creating an OTD from a DTD, 
refer to the Sun SeeBeyond eGate™ Integrator User’s Guide.

A.3 OTD Methods and Business Process Operations
For eGate Collaborations, the PeopleSoft eWay provides the sendMessage() method. For 
eInsight Business Processes, the sendMessage and ProcessRequest operations are 
available. This section describes the method and operations. The PeopleSoft eWay 
provides the following methods:
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sendMessage() method

Syntax

sendMessage()

Description

Used in outbound Collaborations to send a message to the PeopleSoft client using 
HTTP.

Parameters

None.

Return Value

None.

Throws

PSoftHttpApplicationException

sendMessage Operation

Description

Used in outbound Business Processes to send a message to the PeopleSoft client 
using HTTP.

Input and Output

processRequest Operation

Description

Used in inbound Business Processes to process a message received from the 
PeopleSoft server using HTTP.

Input and Output

eInsight Operation Input Output

sendMessage webRequest webResult

eInsight Operation Input Output

processRequest n/a webRequest
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